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ВВЕДЕНИЕ 

 

Целью и задачами преподавания дисциплины «Информационные технологии» 

являются изучение общих принципов создания информационного обеспечения общества; 

понимания возможностей современных технических и программных средств 

информационных систем; понимания целей и механизмов использования информационных 

систем и технологий; формирования определенного мировоззрения в информационной 

сфере и освоения информационной культуры, т.е. умения целенаправленно работать с 

информацией, используя ее для решения профессиональных вопросов. 

Целью практической части дисциплины является обучение студентов технологии 

использования современных программных инструментов в процессе своей работы на 

локальном компьютере или подключенном к сети, с текстами и документами, с базами 

данных, с новейшими инструментальными средствами получения, отображения, обработки, 

хранения и передачи информации. 

Данное методическое пособие содержит подробное описание лабораторных работ, 

каждая из которых направлена на освоение и закрепление определенной темы: 

1. Разработка описания и анализ информационной системы. 

2. Определение требований. 

3. Оценка жизнеспособности проекта и достижимости результатов. 
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Лабораторная работа №1. Создание векторных иллюстраций в 

CorelDraw. 

Цель работы: научиться создавать векторные иллюстрации в CorelDraw 

Задачи работы: 

 основы работы с программой CorelDraw;  

 получение практических навыков работы с объектами; 

 грамотное оформление текста;  

 использование спецэффектов. 

Теоретические положения 

Интерфейс программы 

Программа CorelDRAW X3 открывается в стандартном виде окна приложения 

Windows с печатной страницей в центре. 

Основными элементами окна CorelDRAW являются (рис.1.1): 

 строка заголовка с тремя кнопками управления размером окна, расположенными 

справа: Свернуть, Развернуть/Свернуть в окно, Закрыть; 

 строка меню  Menu Bar); каждое меню содержит множество пунктов, которые 

открывают подменю, выводят на экран диалоговые окна или выполняют конкретные 

команды; 

 панель инструментов (Toolbox) — панель графики; 

 панель свойств (Property Bar) — набор параметров конкретного инструмента, 

выбранного на панели инструментов; 

 цветовая палитра (Color Palette); 

 пристыковываемые окна (Dockers) — элементы, предназначенные для 

настройки параметров выполнения тех или иных действий; они обычно открываются в 

служебной области в правой части окна. 

Элементы стандартной панели инструментов предназначены для выполнения таких 

действий (рис.1.2): 

 
Рис. 1.1. - Окно программы CorelDRAW X3 

Стандартная панель 
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Рис.1.2. - Стандартная панель инструментов 

 

 New (Новый) — создать документ текущего формата печатной страницы; 

 Open (Открыть) — открыть диалоговое окно Open Drawing (Открыть рисунок), 

позволяющее выбрать существующий рисунок и открыть его; 

 Save (Сохранить) — сохранить рисунок; 

 Print (Печать) — открыть диалоговое окно Print (Печать); 

 Cut (Вырезать) — копировать объект в буфер обмена с удалением его с рабочей 

области; 

 Copy (Копировать) — копировать объект в буфер обмена без удаления его с 

рабочей области; 

 Paste (Вставить) — вставить скопированный в буфер обмена объект на рабочую 

область; 

 Undo (Отменить) — отменить выполненное действие; 

 Redo (Вернуть) — повторить действие, отмененное предыдущей командой; 

 Import (Импорт) — импортировать на рабочую область растровое изображение; 

 Export (Экспорт) — экспортировать файл в другой формат; 

 Zoom Levels (Уровни увеличения) — раскрывающийся список, из которого 

можно выбрать один из доступных масштабов просмотра рисунка в окне документа: 

o To Fit (По картинке) — отображение всех объектов рисунка так, чтобы они 

занимали все окно документа; 

o To Selected (По выбранному) — отображение только выделенных объектов 

таким образом, чтобы они занимали все окно документа; 

o To Page (На страницу) — режим показа печатной страницы в центре окна; 

o To Width (По ширине) и To Height (По высоте) — режим подгонки размеров 

изображения печатной страницы под размер окна документа по ширине или по высоте 

соответственно; 

o 10%... 400% — режимы показа печатной страницы рисунка с соответствующим 

уменьшением или увеличением относительно исходного размера (100%). 

Панель инструментов. 

Данная панель содержит инструменты для создания объектов, изменения их формы, 

применения специальных эффектов, работы с цветом и т. п. (рис.1.3). 

Задание 1. Манипулирование объектами 

Различные виды трансформационных искажений (изменение геометрических 

размеров, вращение, сдвиг) позволяют получить из прямоугольника такие фигуры, как 

квадрат, ромб и параллелограмм (рис.1.4). 
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Рис. .1.3. - Развернутый вид панели инструментов: группы  

инструментов 

 
 

Рис. 1.4. - Примеры геометрических фигур, полученных 

 из прямоугольника в результате изменения геометрических размеров,  

вращения и сдвига 

 

Способность прямоугольника к трансформационным изменениям позволяет 

получать разнообразные заготовки, с помощью которых в последующем можно собирать 

более сложные фигуры, как мозаичное полотно. 

Используя настройки, которые появляются на панели свойств при выборе 

инструмента Rectangle (Прямоугольник), можно задавать скругление отдельных углов 

прямоугольника. Благодаря нeзависимости углов друг от друга в результате получаются 

разнообразные заготовки (рис.1.5). 
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Рис. 1.5. - Расположение инструмента Rectangle (Прямоугольник) 

 

Чтобы активизировать инструмент Rectangle (Прямоугольник), выполните 

следующие действия. 

1. Переместите указатель мыши  на кнопку инструмента Rectangle (Прямоугольник) 

( ). 

2. Щелкните кнопкой мыши. 

Выбор инструмента Rectangle (Прямоугольник) сопровождается изменением вида 

указателя мыши на перекрестие с маленьким прямоугольником, а также графическим 

представлением кнопки инструмента в нажатом состоянии на панели графики. 

После того как инструмент Rectangle (Прямоугольник) активизирован, им можно 

многократно пользоваться до тех пор, пока не будет выбран другой. 

Чтобы воспользоваться данным инструментом, выполните следующие действия. 

1. Выберите инструмент Rectangle (Прямоугольник) ( ). 

2. Переведите указатель на рабочую область, нажмите кнопку мыши и, не отпуская 

ее, протащите мышь. При этом будет создан объект — прямоугольник. 

3. Закончите создание прямоугольника, отпустив кнопку мыши (рис.1.6). 

 

 
Рис.1.6. - Результат построения геометрической фигуры с помощью инструмента 

Rectangle (Прямоугольник) 

 

Задание 2. Трансформирование объектов 
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Построенная фигура — прямоугольник — представляет собой объект-заготовку. С 

помощью транформационных искажений, а также задания параметров скругления углов 

прямоугольника получают требуемую фигуру или элемент составной фигуры. 

Выделение объектов 

Действия, связанные с трансформационными искажениями и скруглениями углов 

прямоугольника, лучше всего производить, активизировав инструмент Pick (Выбор) ( ). 

Инструмент Pick (Выбор) очень удобно использовать при работе с объектами, 

поскольку именно он позволяет выбирать построенные объекты или несколько объектов, 

находящихся в рабочей области окна программы CorelDRAW (рис.1.7). 

Чтобы выделить отдельный объект с помощью инструмента Pick (Выбор), 

выполните следующие действия. 

 

 
Рис. 1.7. - Расположение инструмента Pick (Выбор)  

в окне программы CorelDRAW 

1. Наведите острие стрелки указателя мыши ( ) на контур объекта, который 

необходимо выделить (рис. 1.8, а). 

2. Не отводя указатель мыши от контура объекта, выполните щелчок. 

Если при щелчке рука не дрогнула и вы попали острием стрелки указателя на контур 

объекта,то в результате вокруг объекта появится невидимая габаритная рамка (selection 

box), обозначаемая восемью управляющими маркерами (прямоугольники ( ) в углах и на 

серединах сторон) и центром, отмеченным значком (рис.1.8, б). 

 
Рис.1.8. - Расположение указателя мыши при выделении объекта (а) и пример выделенного 

объекта (б) 

 

Чтобы воспользоваться инструментом Pick (Выбор) для выделения нескольких 

объектов (группы), выполните следующие действия. 

1. Выберите инструмент Pick (Выбор) ( ). 

2. Выделите один из объектов будущей группы. 
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3. Нажмите на клавиатуре клавишу Shift и, удерживая ее, продолжайте выбирать 

объекты, указывая на их контуры указателем и щелкая кнопкой мыши. 

4. После того как будет выбран последний объект группы, отпустите клавишу Shift. 

В результате вокруг группы выделенных объектов появится габаритная рамка (рис. 

1.9). 

 
 

Рис. 1.9. - Выделение нескольких объектов (группы) 

Только после того как объект или группа объектов выбрана, можно производить 

действия, связанные с трансформационными искажениями. 

Над всеми объектами или группами объектов в программе CorelDRAW можно 

производить следующие трансформационные искажения (рис. 1.10): 

 перемещение; 

 масштабирование; 

 поворот; 

 наклон; 

 зеркальное отображение. 

 
 

Рис. 1.10 - Примеры трансформационных искажений 

Все виды трансформационных искажений можно выполнять как свободным 

движением руки с помощью мыши, так и точно, путем указания числовых значений 

параметров конкретного искажения. 

Напомню, что вокруг выделенного объекта появляется невидимая габаритная рамка. 

Кроме этого, вверху окна программы отображается панель свойств с доступными 

числовыми значениями искажения данного объекта (рис. 1.11, 1.12). 
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Рис. 1.11. - Выделенный объект и панель свойств с доступными 

числовыми значениями искажения 

 
Рис.1.12. - Панель свойств при выделенном объекте 

 

Чтобы точно изменить геометрические размеры объекта (группы объектов) путем 

задания числовых значений, следует выполнить такие действия (рис.1.13). 

1. Выделить нужный объект (группу объектов). 

2. На панели свойств щелкнуть кнопкой мыши на поле, соответствующем ширине 

или высоте (параметр Object(s) Size (Размер объектов)). 

3. Когда указатель мыши примет вид"I", щелкнуть кнопкой мыши. 

4. Удалить прежнее значение и ввести новое. 

5. Закончить ввод значения нажатием на клавиатуре клавиши Enter. 

 
Рис. 1.13 - Примеры вида указателя мыши при трансформировании 

Повторный щелчок на выделенном объекте (группе объектов) приводит к тому, что 

управляющие маркеры габаритной рамки принимают вид двунаправленных стрелок, 

располагающихся в углах и на серединах сторон. Маркер центра габаритной рамки ( ) 

становится маркером центра вращения и принимает вид . 

Управляющие маркеры габаритной рамки в виде изогнутых двунаправленных 

стрелок, располагающихся на углах, предназначены для поворота объекта (группы 

объектов) вокруг маркера центра вращения ( ) (рис.1.14). 
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Рис. 1.14. - Пример выделенного объекта в режиме  

Rotation (Поворот) 

Чтобы повернуть объект (группу объектов) с помощью мыши, необходимо 

выполнить следующие действия. 

1. Выделить требуемый объект (группу объектов). 

2. Перейти в режим вращения, повторно щелкнув на выделенном объекте (группе 

объектов). 

3. Расположить указатель мыши на любом угловом управляющем маркере в виде 

изогнутой двунаправленной стрелки. 

4. Когда указатель мыши примет вид , нажать кнопку мыши и, не отпуская ее, 

произвести дугообразное движение мышью, поворачивая объект (группу объектов). 

5. Закончить поворот, отпустив кнопку мыши. 

Другой способ вращения объекта (группы объектов) заключается в точном указании 

угла поворота ( Angle of Rotation ) и направления вращения: по часовой стрелке или 

против. Кроме полей, определяющих положение и геометрические размеры выделенного 

объекта или группы, на панели свойств присутствует поле Angle of Rotation (Угол 

поворота).  

Панель Transform (Преобразование) 

Кроме изменения положения центра вращения объекта свободным движением, с 

помощью мыши, существует возможность точного задания положения центра вращения. 

Для этого необходимо отобразить дополнительную панель инструментов — Transform 

(Преобразование) (рис.1.15). 

 
 

Рис. 1.15. - Панель инструментов Transform (Преобразование) 

 

Чтобы отобразить в окне программы данную панель, следует выполнить следующие 

действия. 

1. В строке меню вверху окна программы выбрать пункт Window (Окно), щелкнув 

на нем кнопкой мыши. 

2. Выбрать пункт Toolbars (Панели инструментов). 

3. Из списка доступных панелей инструментов выбрать Transform 

(Преобразование). 

Задание 4. Создание наклонов 

Одним из видов трансформационных искажений является наклон. Наклон, или скос, 

представляет собой параллельное смещение противоположных сторон габаритной рамки. 
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Смещением горизонтальных или вертикальных сторон друг относительно друга 

можно получить различные варианты (рис.1.16). 

 
Рис. 1.16. - Преобразование объекта наклоном 

В каком бы направлении ни производился наклон, стороны, лежащие друг напротив 

друга, параллельно смещаются, как бы скользя. 

Объект можно наклонять как свободным движением руки, с помощью мыши, так и 

точно, путем указания числовых значений. 

Как упоминалось, повторный щелчок на выделенном объекте (группе объектов) 

приводит к замене прямоугольных управляющих маркеров габаритной рамки ( ) 

управляющими маркерами в виде двунаправленных стрелок, располагающихся в углах и на 

серединах сторон. Маркер центра габаритной рамки ( ) превращается при этом в маркер 

центра вращения ( ). 

Управляющие маркеры габаритной рамки в виде прямых двунаправленных стрелок, 

располагающихся на серединах сторон габаритной рамки, используются для наклона 

объекта. 

Чтобы наклонить объект (группу объектов) с помощью мыши, необходимо 

выполнить следующие действия (рис.1.17). 

1. Выделить требуемый объект (группу объектов). 

2. Перейти в режим наклона, повторно щелкнув на выделенном объекте (группе 

объектов). 

3. Расположить указатель мыши на нужном управляющем маркере в виде прямой 

двунаправленной стрелки. 

4. Когда указатель мыши примет вид или , нажать кнопку мыши и, не отпуская 

ее, исказить объект в одном из указанных стрелками направлений. 

5. Закончить искажение освобождением кнопки мыши. 

 
Рис. 1.17. - Наклон объекта 

Кроме того, точно производить искажение объекта в виде наклона можно указанием 

величины угла наклона на панели Transform (Преобразование) (параметр Skew Angle 

(Угол наклона)). 

При выделении объекта (группы объектов) параметр Skew Angle (Угол наклона) 

используют для ввода углов наклона по горизонтали и вертикали. 

Чтобы точно, путем указания числового значения угла наклона, исказить объект 

(группу объектов), следует выполнить такие действия. 

1. Выделить требуемый объект (группу объектов). 

2. Расположить указатель мыши на требуемое поле Skew Angle (Угол наклона) на 

панели Transform (Преобразование). 

3. Когда указатель мыши примет вид "I", щелкнуть кнопкой мыши. 
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4. Ввести значение угла наклона. 

5. Закончить ввод значения нажатием клавиши Enter на клавиатуре. 

Значение угла наклона можно задать как положительным, так и отрицательным 

числом. Знак указывает на направление наклона (рис.1.18). 

 
Рис. 1.18. - Влияние знака угла наклона на направление скоса 

 

Задание 5. Зеркальное отображение 

Название инструмента Mirror (Зеркальное отображение), расположенного на панели 

свойств, говорит само за себя. 

Существует два вида зеркального отображения: горизонтальное и вертикальное. При 

горизонтальном зеркальном отображении левая половина объекта становится правой (как 

при переворачивании книжной страницы) (рис.1.19). 

 
Рис. 1.19. - Пример горизонтального зеркального отображения 

Вертикальное зеркальное отображение можно сравнить с отрывным настенным 

календарем, когда страницы перелистываются снизу вверх, то есть верхняя половина 

объекта становится нижней (рис.1.20). 

 
Рис. 1.20 - Пример вертикального зеркального отображения 

 

Чтобы зеркально отразить объект, необходимо действовать следующим образом. 

1. Выделить требуемый объект. 

2. Щелкнуть на одной из кнопок зеркального отображения (Mirror ) на панели 

свойств. 

Таким образом, на примере прямоугольника мы рассмотрели различные виды 

трансформационных искажений, которые в программе CorelDRAW можно выполнять над 

всеми объектами или группами объектов, а не только над прямоугольником. Еще раз 

перечислю эти искажения: 

 перемещение, 

 масштабирование, 

 вращение, 

 смещение, 

 зеркальное отображение. 



16 
 

Чтобы удалить объект (объекты), следует выделить его и нажать на клавиатуре 

клавишу Delete. Выделенным объектам можно задавать цвет заливки, для чего необходимо 

щелкнуть на требуемом цвете на цветовой палитре. 
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Лабораторная работа №2. Создание изображений в Adobe Photoshop 

Цель работы: 

 Настройка интерфейса программы.  

 Понятие «рабочее пространство» (workspace).  

 Работа со слоями. Работа с текстом.  

 Использование инструментов коррекции изображения.  

 Создание рамок. 

 Работа с инструментом клонирование 

Теоретические положения 

Панель инструментов 

Для того чтобы активизировать инструмент, пиктограмма которого в данный момент 

видна на экране, щелкните по ней. Рядом с некоторыми пиктограммами расположена 

маленькая стрелочка. Если по ней щелкнуть, раскроется всплывающая палитра, где можно 

выбрать инструмент, входящий в ту же группу.  

Еще удобнее вызывать инструменты при помощи клавиатуры (запомните буквы, 

указанные на следующих страницах для каждого инструмента). Чтобы попеременно 

вызывать входящие в какую-либо группу инструменты, пиктограммы которых спрятаны, 

нажимайте клавишу Shift и соответствующую «горячую» клавишу. Также можно, нажав 

клавишу Alt, щелкнуть по пиктограмме видимого инструмента.  

Для каждого инструмента задаются свои собственные параметры (например, режим 

смешивания, значение непрозрачности) на панели опций, расположенной вверху экрана. 

Состав параметров на панели опций изменяется в зависимости от того, какой инструмент 

выбран.  

На панели опций с правой стороны расположена пиктограмма активного инструмента. 

Если щелкнуть по стрелочке рядом с пиктограммой, раскроется выпадающее меню, где 

можно выбрать другой инструмент. Этот список можно редактировать, удалять редко 

используемые и добавлять часто применяемые инструменты. Установки на панели опций 

сохраняются для каждого инструмента, если их не изменить или не восстановить 

принимаемые по умолчанию. Загрузить, добавить и сохранить различные комбинации 

кнопок, а также восстановить принимаемые по умолчанию характеристики инструмента 

можно с помощью команд меню выпадающей панели. Для того чтобы восстановить 

принимаемые по умолчанию значения опций для всех инструментов, там же выберите 

команду Reset All Tools (Восстановить все инструменты) либо щелкните по кнопке Reset 

All Tools в окне Edit > Preferences > General (Правка > Установки > Общие) (рис.2.1).  
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Рис. 2.1 - Панель выбора инструмента  

 

На рис. 2.2-2.23 показаны панели инструментов программы Photoshop 7. Рядом с 

названием групп инструментов указана «горячая клавиша» для вызова инструментов, 

входящих в эту группу.  

 
Рис. 2.2 – Панель 

 инструментов  

 

 
Рис. 2.3 - Палитра  

инструментов для выделения  

области геометрической 

формы  
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Рис. 2.4 - Палитра  

инструментов для выделения  

области произвольной формы  

 
Рис. 2.5 - Палитра  

инструментов для устранения 

дефектов изображений  

 
Рис. 2.6 – Палитра 

инструментов клонирования  

 
Рис. 2.7 - Палитра  

инструментов стирания  
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Рис. 2.8 - Палитра  

инструментов, 

контролирующих четкость 

границ изображения  

Рис. 2.9. - Палитра  

инструментов прямого  

выделения  

 
Рис. 2.10 - Палитра  

инструментов для работы с 

контурами  

 
Рис. 2.11 - Палитра 

инструментов для создания 

примечаний  

 
Рис. 2.12 – Палитра 

 инструментов для работы с 

ломтиками  

 
Рис. 2.13 - Палитра 

инструментов рисования  
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Рис.2.14 - Палитра  

инструментов для работы с  

историей создания 

изображения  

 
Рис. 2.15 - Палитра  

инструментов заливки 

 
Рис. 2.16 - Панель  

инструментов для осветления 

и затемнения изображений  

 
Рис. 2.17 - Панель  

инструментов для работы  

с текстом  
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Рис. 2.18 - Панель векторных 

инструментов рисования  

Рис. 2.19 - Панель  

инструментов для работы с  

цветом, углами и 

расстояниями  

 

Рис. 2.20 - Примечание, созданное с помощью инструмента Notes  

 
Рис. 2.21 - Область на панели опций, предназначенная для хранения палитр  

 
Рис. 2.22 - Панель опций для инструмента Brush  

 
Рис. 2.23 - Панель опций для инструмента Rectangular Marquee  

 

Задание 1. Создание нового изображения  

1. Выберите File > New (Файл > Новый) или воспользуйтесь комбинацией клавиш 

Ctrl+N.  

2. Введите какое-либо имя в поле Name (Имя).  

3. В выпадающих меню, расположенных рядом с полями Width (Ширина) и Height 

(Высота), выберите единицу измерения.  

4. Введите значения параметров Width и Height.  

5. Введите значение параметра Resolution (Разрешение), необходимое для вывода 

изображения независимо от того, будет ли оно выводиться на фотонаборное 
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устройство или передаваться по сети (вопросы выбора разрешения рассматривались 

в этой главе выше).  

6. Из всплывающего меню Mode (Режим) выберите режим изображения. Позднее 

можно будет преобразовать изображение в другой режим.  

7. Поставьте переключатель Contents (Содержимое) в положение White (Белый) или 

Background Color (Фоновый цвет). 

8. Щелкните по кнопке ОК (клавиша Enter). Появится окно изображения.  

 

Задание 2. Открытие изображения в программе Photoshop  

Для того чтобы открыть файл Adobe Illustrator, следуйте инструкциям, приведенным в 

разделах «Открытие файлов в формате EPS, PDF или программы Illustrator как нового 

изображения» или «Размещение файлов в формате EPS, PDF или программы Illustrator в 

существующем изображении Photoshop».  

1. Выберите команду меню File > Open (Файл > Открыть), File > Browse (Файл > 

Просмотр) или воспользуйтесь комбинацией клавиш Ctrl+O.  

2. Выделите файл, который хотите открыть (рис. 2.24). Если изображение было 

сохранено с уменьшенной копией для предварительного просмотра, щелкните по 

кнопке Show Preview (Предварительный просмотр), чтобы увидеть образец 

изображения. В случае открытия с помощью команды File > Browse все 

изображения в поддерживаемых форматах будут показаны в виде их уменьшенных 

копий, и достаточно просто щелкнуть мышью по необходимому (рис. 2.25).  

3. Выделите имя файла и щелкните по кнопке Open (Открыть) или дважды щелкните 

по имени файла.  

 

 
Рис. 2.24 - Открытие файла  
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Рис. 2.25 - Открытие файла с помощью команды Browse  

 

Для некоторых форматов может появиться еще одно диалоговое окно. Например, если 

открывать EPS, Adobe Illustrator или PDF-файл, который еще не был преобразован из 

векторной формы в растровую, появится диалоговое окно Rasterize Generic Format 

(Растеризация формата).  

 

Задание 3. Сохранение нового изображения  

1. Выберите команду File > Save (Файл > Сохранить) или воспользуйтесь 

комбинацией клавиш Ctrl+S.  

2. В поле File name (Имя файла) введите имя файла.  

3. Выберите месторасположение файла. Для того чтобы указать другую папку или 

диск, выберите ее/его из ниспадающего меню, расположенного в верхней части 

диалогового окна.  

4. Из всплывающего меню Save As (Сохранить как) выберите формат файла (рис. 

2.26). Многослойные изображения могут быть сохранены только в форматах Photoshop, 

Advanced TIFF и Photoshop PDF.  

5. В группе параметров Save (Сохранить) установите необходимые флажки; также 

можно поставить флажок Color: Embed Color Profile (Цвет: Встроенный цветовой 

профиль), если в файле содержится профиль, а формат, в котором вы его сохраняете, 

поддерживает встроенные профили.  

6. Щелкните по кнопке Save (Сохранить).  

Также если хотите, чтобы с каждым изображением, содержащим слои, автоматически 

сохранялась копия без слоев, установите флажок Maximize backwards compatibility in 

Photoshop formats (Максимальная совместимость форматов Photoshop). Это полезно, если 

изображение будет экспортировано в другое приложение.  
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Рис. 2.26. - Диалоговое окно Save As 

 

Задание 4. Изменение размеров изображения и разрешения  

Изменение размеров изображения в пикселах при выводе на экран  

1. Выберите команду меню Image > Image Size (Изображение > Размер изображения).  

2. Убедитесь, что флажок Resample Image (Отслеживать изменения) установлен.  

3. Для того чтобы сохранить соотношение ширины и высоты изображения, не 

снимайте флажок Constrain Proportions (Сохранять пропорции).  

4. Установите разрешение равным 72 ppi.  

5. Введите новые значения параметров группы Pixel Dimensions (Размеры в пикселах): 

Width (Ширина) и/или Height (Высота).  

6. Щелкните по кнопке ОК.  

Команда Resize Image (Изменить размеры изображения) копирует изображение и 

автоматически изменяет размеры дубликата. Вы должны лишь установить значения в 

последовательно появляющихся диалоговых окнах, все остальное за вас сделает программа 

Photoshop.  

1. Выберите команду меню Help > Resize Image (Помощь > Изменить размеры 

изображения).  

2. Установите переключатель в положение Print (Печать) или Online (Онлайн), 

затем щелкните по кнопке Next (Дальше).  

3. Введите желаемый размер изображения при выводе, затем щелкните по кнопке 

Next (Дальше). Если на предыдущем шаге вы установили режим Online, щелкните по 

кнопке Finish (Готово). Для вывода изображения на печать выполните оставшиеся шаги.  

4. Отметьте предложенное значение или введите другую линиатуру растра в 

соответствии с указаниями типографии, затем щелкните по кнопке Next (Дальше).  

5. Передвиньте ползунок Quality (Качество), и обратите внимание на 

окончательный размер изображения, показанный в области Results (Результат). Если ниже 

было выведено какое-либо сообщение, прочитайте его. Если хотите продолжить, щелкните 

по кнопке Next (Дальше).  

6. Щелкните по кнопке Finish (Готово) и сохраните изображение, размеры которого 

были изменены. Либо щелкните по кнопке Cancel (Отмена).  

 

Задание 5. Кадрирование изображения с помощью рамки  
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Изображение может быть обрезано с помощью инструмента Crop (Кадрировать), 

команды Crop (Кадрировать) или команды Trim (Подрезать). В программе Photoshop 7 

содержатся несколько новых опций для инструмента Crop (Кадрировать).  

1. Выберите инструмент Crop (Кадрировать), или нажав клавишу С.  

2. Нарисуйте рамку вокруг той области изображения, которую вы хотите сохранить. 

3. Выполните любое из нижеследующих действий на панели опций инструмента 

Crop (Кадрировать).  

Установите флажок Shield cropped area (Прикрыть область кадрирования), если 

хотите, чтобы область за пределами рамки была затемнена (это поможет лучше увидеть, 

что останется). Щелкните по образцу Color (Цвет), если хотите изменить цвет затемненной 

области и выберите значение параметра Opacity (Непрозрачность) для этого цвета.  

Если вы кадрируете слой, поставьте переключатель Cropped Area (Отсекаемая 

область) в положение Delete (Удалить), чтобы удалить область, не заключенную в рамку, 

или Hide (Спрятать), чтобы сохранить область вместе с файлом и чтобы область 

находилась за пределами изображения. С помощью инструмента Move (Переместить) 

можно переместить спрятанные пикселы слоя, находящиеся за пределами изображения. Эта 

функция не доступна для фона.  

Описание опции Perspective (Перспектива) приведено в интерактивной 

документации Photoshop.  

4. Выполните любой из нижеследующих шагов.  

Для того чтобы изменить размер рамки, перетащите один из маркеров ее границы 

(курсор примет вид двухсторонней стрелки). Если при этом нажать клавишу Shift, будут 

сохранены пропорции рамки. Нажав клавишу Alt, можно изменить размер рамки 

относительно ее центра.  

Чтобы передвинуть рамку, поместите курсор внутри рамки и перетащите ее. Если 

надо повернуть рамку, поместите курсор за ее пределами (появится изогнутая стрелочка) и 

тащите его по кругу. Чтобы изменить положение оси, вокруг которой будете поворачивать 

рамку, предварительно перетащите кружок, находящийся в центре рамки. (Нельзя 

повернуть рамку, если изображение имеет представление Bitmap.)  

5. Нажмите клавишу Enter.. Чтобы завершить операцию, можно также дважды 

щелкнуть мышью внутри рамки. Если вы повернули рамку, потребуется некоторое время 

на завершение операции обрезки.  

 

Задание 6. Увеличение холста изображения с помощью  

инструмента Crop  

Если произвести обрезку с помощью рамки, размер которой больше размера самого 

изображения, увеличится размер холста изображения.  

1. Увеличьте окно изображения так, чтобы был виден рабочий холст (серая область) 

вокруг изображения.  

2. Выберите инструмент Crop, или нажав клавишу С.  

3. Нарисуйте рамку обрезки внутри изображения.  

4. Перетащите маркеры рамки в область рабочего холста (рис. 2.27, 2.28). Если 

границы изображения вышли за границу холста, эти области будут включены в холст.  
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Рис. 2.27 - Перемещение маркеров рамки за пределы холста 

 
Рис. 2.28 - Заливка добавленных пикселов текущим фоновым цветом (темно-серым) и 

изменение пропорций изображения  

5. Дважды щелкните мышью внутри рамки или нажмите клавишу Enter. Если 

пикселы не были скрыты, дополнительная область холста либо будет залита текущим 

фоновым цветом, если самый нижний слой - фон, либо будет прозрачной, если самым 

нижним является какой-либо иной слой.  

6. Переворачивание изображения.  

 

Задание 7. Перетаскивание выделенной области между  

изображениями  

Если перетащить выделенные пикселы с одного изображения в другое, они будут 

скопированы на новый слой целевого изображения. Метод перетаскивания (drag-and-drop) 

не затрагивает буфер обмена, экономит память и сохраняет содержимое буфера.  

Если ваш монитор слишком мал, чтобы одновременно отображать два окна 

изображения, воспользуйтесь методом копирования-вставки (рис.2.29, 2.30).   
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Рис. 2.29. Перемещение области фона в буфер обмена посредством команды Edit > Сору  

 
Рис. 2.30. Расположение вставленного фрагмента в новом слое  

 

Откройте исходное и целевое изображения и расположите окна так, чтобы они не 

закрывали друг друга полностью.  

В исходном изображении выделите какую-либо область, расположенную на слое или 

фоне.  

1. Активизируйте инструмент Move (Перемещение) или нажав клавишу 

V. Также доступ к этому инструменту можно получить, нажав клавишу Ctrl во 

время работы многих других инструментов.  

2. На панели опций инструмента Move установите флажок Show 

Bounding Box (Показать границы), если необходимо, чтобы была видна рамка 

выделенной области.  

3. Перетащите выделенный фрагмент на целевое изображение, отпустите 

кнопку мыши там, где хотите поместить его (рис. 2.31, 2.32). Скопированный 

образ появится на новом слое. С помощью инструмента Move (Перемещение) 

можно его переместить. При этом исходное изображение не изменится.  

 
Рис. 2.31 - Перетаскивание выделенной области с фона с временной заливкой фоновым 

цветом открывшегося участка  

 
Рис. 2.32 - Появление черной границы в окне целевого изображения  
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Задание 8. Вставка в выделенную область  

Если воспользоваться командой Paste Into (Вставить в) для того, чтобы вставить 

содержимое буфера обмена в выделенную область, автоматически будет создан новый слой 

и активная рамка выделения станет границей маски слоя. Затем вставленное изображение 

можно переместить внутри маски слоя или изменить форму самой маски, так чтобы стало 

видно большее или меньшее число пикселов.  

1. Выделите область слоя. Если вы хотите растушевать выделенную область, 

выберите команду Select > Feather (Выделить > Растушевать) и введите требуемое 

значение.  

2. Выполните команду Edit > Сору (Правка > Копировать), чтобы скопировать 

пикселы только активного слоя или Edit > Copy Merged (Правка > Копировать 

объединенные слои) (комбинация клавиш Ctrl+Shift+C), чтобы скопировать пикселы 

выделенной области всех видимых в данных момент слоев.  

3. Оставьте тот же слой активным либо выделите другой слой, либо выберите 

какой-либо слой другого изображения.  

4. Выделите область (области), в которую вы хотите вставить содержимое буфера 

обмена.  

5. Выберите команду Edit > Paste Into (Правка > Вставить в) или нажмите 

комбинацию клавиш Ctrl+Shift+V. Будет создан новый слой и маска слоя.  

Для создания эффекта, «музыкальный» слой был выделен и скопирован. В другом 

изображении при нажатой клавише Ctrl щелкнули по слою текста, затем выполнили 

команду Edit > Paste Into (Правка > Вставить в). В результате появился новый слой.  

6. Можно также использовать дополнительные опции.  

 

Задание 9. Увеличение резкости и размытие изображений  

Инструмент Blur (Размытие) уменьшает контраст между точками. Воспользуйтесь им, 

чтобы смягчить границы между фрагментами изображения. Инструмент Sharpen (Резкость) 

увеличивает контраст между пикселами, поэтому его используют для того, чтобы очертить 

границы фигур. Ни один из этих инструментов не может быть использован для 

изображения в режиме Bitmap или Indexed Color.  

1. Активизируйте инструмент Blur (Размытие) или Sharpen (Резкость) 

(клавиша R или Shift+R). Для каждого инструмента на панели опций сохраняются 

собственные значения параметров.  

2. На панели опций выбранного инструмента щелкните по стрелке поля 

Brush (Кисть) и выберите кисть с четкими или расплывчатыми контурами.  

Выберите режим смешивания в поле Mode (Режим). Вариант Normal (Нормальный) 

означает увеличение резкости/размытия пикселов любого оттенка. В случае Darken 

(Темный) воздействие оказывается только на те пикселы, которые темнее основного цвета. 

В режиме Lighten (Светлый) - только на те пикселы, которые светлее основного цвета. В 

режиме Hue (Тон) или Color (Цвет) инструмент несколько усилит дополнительные цвета, а 

в режиме Saturation (Насыщенность) - существующие цвета. Режим Luminosity (Яркость) 

означает увеличение яркости. Различия в режимах более заметны при работе с 

инструментом Sharpen (Резкость), нежели с инструментом Blur (Размытие). Выберите 

величину параметра Pressure (Нажим) в процентах.  
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3. По желанию. На панели опций установите флажок Use All Layers 

(Использовать все слои), чтобы взять пикселы, расположенные под курсором, и с 

других видимых слоев; в дальнейшем пикселы будут размещены в активном слое.  

4. В окне изображения протащите курсор через ту область, резкость или 

размытие которой необходимо увеличить. Для усиления эффекта повторите 

операцию.  

 

Задание 10. Клонирование областей в одном изображении  

 

Инструмент Clone Stamp (Клонирующий штамп) используется для переноса клона 

объекта с одного слоя на другой в пределах одного и того же многослойного изображения 

или с одного изображения на другое.  

1. Активизируйте инструмент Clone Stamp (Клонирующий штамп), или 

нажав клавишу S или Shift+S.  

2. На панели опций инструмента щелкните по стрелке поля Brush 

(Кисть), затем выберите размер кисти, подходящий для области, которую вы хотите 

клонировать.  

Выберите режим смешивания в поле Mode (Режим), а также значение параметра 

Opacity (Непрозрачность) в процентах.  

Установите флажок Aligned (Выровненный), чтобы создать единый неразрывный 

клон области, связанный с одной исходной точкой. Можно отпустить кнопку мыши и 

перейти к другому фрагменту и, кроме того, изменить режим и размер кисти между 

нанесением штрихов. Снимите флажок Aligned (Выровненный), чтобы создать несколько 

клонов, соответствующих одной и той же исходной точке. Курсор в виде перекрестия будет 

возвращаться к этой исходной точке каждый раз, как вы отпускаете кнопку мыши.  

Установите флажок Use All Layers (Использовать все слои), чтобы выбирать 

пикселы со всех видимых в данный момент слоев, по которым вы щелкаете при нажатой 

клавише Alt. Снимите этот флажок, чтобы выбирать пикселы только с активного слоя.  

3. На палитре Layers (Слои) выберите слой, фрагмент которого хотите 

клонировать.  

4. В окне изображения, нажав клавишу Alt, щелкните по области слоя, 

которую вы хотите клонировать, чтобы создать исходную точку. Не щелкайте по 

прозрачной области слоя, там нечего клонировать.  

5. На этом же слое перетаскивайте курсор в то место, где, по вашему 

мнению, должна появиться копия фрагмента изображения. (Можно также выбрать 

или создать другой слой, а затем перетаскивать там курсор.) На экране появятся два 

курсора: перекрестие над исходной точкой и курсор инструмента Clone Stamp 

(Клонирующий штамп) или пиктограмма кисти там, где вы перетаскиваете курсор. 

Картинка, над которой находится перекрестие, «проявится» в том месте, где вы 

перетаскиваете курсор, и заменит нижележащие пикселы.  

6. По желанию. Чтобы создать новую исходную точку для операции 

клонирования, нажмите клавишу Alt и щелкните по другой области исходного 

изображения.  

Увеличение контрастности изображения  
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С помощью диалогового окна Threshold (Порог) можно увеличить контраст текущего 

слоя или фона, преобразовав цветные или серые пикселы в черные и белые.  

1. Выберите какой-либо слой или фон, а затем воспользуйтесь командой 

Image > Adjustments > Threshold (Изображение > Корректировки > Порог).  

Чтобы задействовать корректирующий слой, из всплывающего меню, которое 

вызывается при помощи кнопки Create new fill or adjustment layer (Создать новый слой 

заливки или корректирующий слой), расположенной внизу палитры Layers (Слои), 

выберите команду Threshold (Порог).  

2. Передвиньте ползунок вправо, чтобы увеличить число черных 

пикселов, или влево, чтобы увеличить число белых.  

Можно также в поле Threshold Level (Уровень порога) ввести какое-либо значение 

(от 1 до 255). Пикселы светлее выбранного значения станут белыми, а остальные - 

черными.  

3. Щелкните по кнопке ОК.  

 

Задание 11. Создание текста  

 

Различные виды текста  

Как только с помощью инструмента Туре (Текст) был создан текст в программе 

Photoshop, он автоматически появляется на своем собственном слое. В любой момент 

можно изменить его атрибуты: шрифт, стиль, кегль, цвет, кернин, трекинг, межстрочный 

интервал, выравнивание, положение относительно базовой линии. Кроме того, различные 

атрибуты могут быть установлены для разных букв в одном и том же текстовом слое.  

Также допускается изменять содержание текста, применять к нему разные эффекты 

слоя, изменять режим смешивания и уровень непрозрачности. Что же можно сделать с 

редактируемым текстовым слоем? Можно применить фильтры, очертить текст или 

заполнить его градиентом или рисунком. Чтобы осуществить эти операции, необходимо 

преобразовать текстовый слой в растровый формат с помощью команды меню Layer > 

Rasterize > Туре (Слой > Преобразовать в растровый формат > Текст). Текст, показанный на 

рис. 2.33, сначала был преобразован в растровый формат, а затем к нему применили 

фильтры и эффекты слоя (рис.2.34).  

 
Рис. 2.33 - Редактируемый векторный текст  
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Рис. 2.34. Текст, подвергнутый преобразованию  

 

Любые типы текста (редактируемый и др.) создаются с помощью инструмента Туре 

(Текст), меню Layer (Слои), палитры Character (Шрифт), палитры Paragraph (Абзац) и 

панели опций.  

Также с помощью инструмента Туре в активном слое выделяют фрагмент текста, который 

можно преобразовать в маску слоя, сохранить в альфа-канале или сохранить в виде слоя 

фигуры (типа shape) для дальнейшего использования.  

Редактируемый текст (в противоположность тексту, созданному как выделение в 

активном слое) автоматически появляется в своем собственном слое, и в дальнейшем его 

можно редактировать, перемещать, трансформировать, менять его положение относительно 

других слоев, словом, выполнять над ним различные операции, не влияя на другие слои. 

Работая с программой Photoshop , не нужно беспокоиться о том, куда изначально поместить 

текст и какие его атрибуты выбрать, так как впоследствии все это легко изменить.  

 

Задание 12. Создание редактируемого текстового слоя  

1. Сначала активизируйте инструмент Туре (Текст), который вызывается нажатием 

клавиши Т.  

2. Чтобы определить начальную точку для текста в режиме построчного ввода, щелкните 

в окне (обратите внимание на изменения в правой части панели опций инструмента). 

Для ввода текстового блока нарисуйте пунктирный контур, тем самым определив 

границы текста, в которых будут применяться атрибуты абзаца. Лучше располагать 

отдельные слова или даже символы в отдельных слоях, что позволит перемещать их 

независимо друг от друга (рис.2.35).  

 
Рис. 2.35 - Размещение элементов текста в отдельных слоях  

 

3. На панели опций выполните следующие действия:  

o щелкните по кнопоке Туре на панели опций инструмента Туре, чтобы поменять 

ориентацию теста (по горизонтали/по вертикали) (рис.2.36-2.37);  
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Рис. 2.36 - Фрагмент панели опций инструмента Туре 

 

 
Рис. 2.36 - Левая сторона панели опций нструмента Туре  

 
Рис. 2.37 - Правая часть панели опций инструмента Туре  

 

o выберите семейство шрифтов, стиль и кегль шрифта (последний можно ввести 

вручную);  

o также укажите в поле Anti-aliased (Сглаживание) один из методов сглаживания 

границ литер: Sharp (Резкое) Crisp (Жесткое),-Strong (Сильное), или Smooth 

(Гладкое). Это позволит сгладить границы текста как с маленьким, так и со 

средним кеглем, добавляя полупрозрачные точки вдоль границ.  

Щелкните по одной из кнопок группы Alignment (Выключка), чтобы выровнять текст 

относительно первой точки (построчный режим ввода) или относительно левой, правой 

границы или по центру окна (при вводе текстового блока) (рис.2.38).  

 
Рис. 2.38 - Способы выравнивания текстового блока  

 

Выберите цвет текста, щелкнув по полю образца на панели опций и выбрав цвет на 

всплывающей панели. Цвет текста можно указать также с помощью палитр Swatches 

(Образцы) или Colors (Цвета).  

Щелкните по кнопке Palettes (Палитры), чтобы открыть палитры Character (Шрифт) и 

Paragraph (Абзац) - и выбрать необходимые атрибуты (об этих палитрах более подробно 

рассказано ниже в этой главе).  

4. Наберите текст в окне изображения.  

5. Для того чтобы создать новый текстовый слой, нажмите клавишу Enter . Если же в 

этом нет необходимости, то нажмите клавишу Esc.  

 

Задание 13. Масштабирование текста  
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Пользуйтесь командами Horizontal Scale (Масштаб по горизонтали) и Vertical Scale 

(Масштаб по вертикали) только в том случае, если желаете исказить буквы (удлинить или 

укоротить их). Для равномерного масштабирования литер воспользуйтесь инструкциями, 

приведенными ниже, либо выделите необходимые символы и поменяйте кегль в палитре 

Character (Шрифт) (рис.2.39).  

 
Рис. 2.39 - Поля для ввода масштаба  

 

Масштабирование выбранных символов  

1. В палитре Layers (Слои) выберите слой, содержащий текст.  

2. Откройте палитру Character (Шрифт). Это можно сделать, выбрав 

соответствующую команду в меню Window (Окно), либо активизировав инструмент 

Туре (Текст) (клавиша Т) и щелкнув по кнопке Palettes (Палитры) на панели опций.  

3. По желанию. С помощью инструмента Туре выделите те символы, 

которые следует масштабировать. Иначе будут искажены все символы в слое.  

4. Измените значения масштаба в полях Horizontal Scale (Масштаб по 

горизонтали) и/или Vertical Scale (Масштаб по вертикали) в палитре Character 

(Шрифт). Если текст не выделен и, кроме того, желаемое значение в одном из полей 

было введено вручную, а не выбрано из всплывающего меню, то для выполнения 

масштабирования следует нажать клавишу Enter (рис.2.40).  

 
Рис. 2.40 - Изменение вида текста в результате изменения  

масштаба  

 

Масштабирование всего текста на слое  

1. Активизируйте инструмент Move (Перемещение).  

2. Установите флажок Show Bounding Box (Показать габаритную рамку) 

на панели опций инструмента.  

3. Выделите имя слоя в палитре Layers (Слои).  
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4. Перетащите габаритную рамку за ее угол, чтобы одновременно 

поменять масштаб по вертикали и по горизонтали, а если надо изменить только одну 

из величин, перетаскивайте боковой манипулятор рамки. Подождите, пока 

программа закончит перерисовку текста. Для сохранения пропорций текста 

проделайте то же самое при нажатой клавише Shift.  

 

Задание 14. Специальные эффекты для текста  

Вы можете перемещать, изменять масштаб, вращать и наклонять габаритную рамку в 

редактируемом текстовом слое, но чтобы исказить текст или применить команду для 

изменения перспективы, необходимо преобразовать текстовый слой в растровый формат. 

Во-вторых, нельзя трансформировать выделенный фрагмент текста. Команды 

трансформации, о которых сначала пойдет речь, изменяют форму текста и габаритной 

рамки.  

С помощью инструмента Move (Перемещение), который активизируется клавишей V, 

можно трансформировать и текст, введенный построчно, и текстовые блоки. Установите 

флажок Show Bounding Box (Показать габаритную рамку) на панели опций и выделите 

текстовый слой на палитре Layers (Слои). На экране будет отображена габаритная рамка 

для текста. Перетащите один из манипуляторов, чтобы изменить расположение текста, при 

этом используйте те же приемы, что и в случае команды Free Transform.  

Текст, введенный построчно, и текстовый блок могут быть изменены следующим 

образом:  

 выделите текстовой слой в палитре Layers (Слои), а в меню Edit (Правка) выполните 

команду Free Transform (Произвольная трансформация) (рис.2.41-2.44);  

 
Рис. 2.41 - Исходный текст  

 
Рис. 2.42 - Изменение формы литер в результате масштабирования  
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Рис. 2.43 - Изменение формы литер в результате перекоса  

габаритной рамки  

 
Рис. 2.44 - Вращение текста без изменения формы символов  

 

 перетаскивайте манипуляторы .габаритной рамки, чтобы изменить форму текста. Это 

можно сделать при любом активном инструменте, за исключением Реn (Перо), а также 

инструментов для построения фигур и выделения контура.  

 

Задание 15. Преобразование текста в растровый формат  

Чтобы обрабатывать текст при помощи фильтров или инструментов, таких как Brush 

(Кисть), Blur (Размытие), Eraser (Ластик), Smudge (Палец), либо команды Distort 

(Исказить) или команды Perspective (Перспектива) из подменю Transform, сначала 

необходимо преобразовать текст в растровый формат. Но надо помнить о том, что как 

только вы преобразовали текст в растровый формат, его типографские атрибуты уже 

изменить нельзя, хотя он и остается в своем слое.  

1. В палитре Layers (Слои) выберите нужный слой. Если необходимо сохранить 

исходный редактируемый слой для дальнейшего использования, то создайте его дубликат и 

работайте с ним.  

2. Выполните команду меню Layer > Rasterize > Туре (Слой > Преобразовать в 

растровый формат > Текст). При этом можно изменять текст, преобразованный в растр, 

неограниченным числом способов - дайте волю своей фантазии. Мы вам предлагаем один 

из вариантов. В палитре Layers (Слои) установите флажок Lock transparent pixels 

(Зафиксировать прозрачные пикселы), заполните растеризованный текст каким-либо 

узором, примените к нему фильтр, снимите флажок Lock transparent pixels, а затем с 

помощью инструмента Smudge (Палец) размажьте края текста (рис.2.45, 2.46).  
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Рис. 2.45 - Текст, заполненный узором в режиме Difference (слева), после применения 

фильтра Fresco (справа)  

 
Рис. 2.46. Текст, заполненный узором c использованием градиента (слева), после 

применения фильтра Palette Knife (справа)  

 

Для того чтобы раскрасить растеризованный текст, выберите инструмент Brush 

(Кисть) и цвет. Установите флажок Lock transparent pixels (Зафиксировать прозрачные 

пикселы) и сделайте несколько мазков кистью на рисунке (рис.2.47). Чтобы нарисовать что-

нибудь за текстом, сделайте это на слое, лежащем ниже текстового (рис.2.48).  

 
Рис. 2.47 - Расположение слоев изображения  

 

 
Рис. 2.48 - Результат раскрашивания растеризованного текста и слоя под ним  

Если был применен эффект Color Overlay (Наложение цвета), Gradient Overlay 

(Наложение градиента) или Pattern Overlay (Наложение узора), то выбирайте режим 

смешивания, который позволит цветовым мазкам просвечивать сквозь текст.  

 

Задание 16. Отображение рисунка за слоем текста  
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1. Выберите изображение для фона в палитре Layers (Слои). Следуя приведенным 

ниже инструкциям, можно осветлить фоновое изображение под слоем эффекта Drop 

Shadow (Отбросить тень).  

2. Выполните команду Layer > New Adjustment Layer > Levels (Слой > Coздать 

корректирующий слой > Уровни), а затем щелкните по кнопке ОК.  

Можно выбрать пункт Levels (Уровни) из всплывающего меню, вызываемого 

нажатием кнопки Create new fill or adjustment layer (Создать новый слой заливки или 

корректирующий слой), расположенной в нижней части палитры Layers (Слои):  

3. Установите флажок Preview (Предварительный просмотр).  

4. Передвиньте серый ползунок Input (Ввод) немного влево, а черный ползунок 

Output (Вывод) - немного вправо.  

5. Щелкните по кнопке ОК (рис.2.49, 2.50).  

 
Рис. 2.49 - Результат применения команды Levels к корректирующему слою над 

фоновым рисунком  

 
Рис. 2.50 - Результат заполнения корректирующего слоя  

градиентом от-черного-к-белому для того, чтобы замаскировать действие эффекта 

Levels в верхнем правом углу  

Для дальнейшей корректировки уровней попробуйте различные режимы 

смешивания, например Screen (Экран) или Overlay (Перекрытие), либо различные уровни 

непрозрачности для корректирующего слоя Levels.  

Для того чтобы корректирующий слой затрагивал только слой, лежащий 

непосредственно под ним, нажав клавишу Alt, щелкните по линии между двумя слоями на 

палитре Layers (Слои).  

 

Задание 17. Отображение текста позади слоя с рисунком  

 

1. Создайте текстовый слой.  



39 
 

2. Создайте дубликат текстового слоя, перетащив его на кнопку Create new layer 

(Создать новый слой), расположенную в нижней части палитры Layers (Слои). Скройте 

исходный текстовый слой (сохраните для будущего редактирования).  

3. Выделите дубликат слоя, а затем выполните команду Layer > Type > Convert to 

Shape (Слой > Текст > Преобразовать в фигуру). Текстовый слой будет преобразован в 

слой типа shape с контуром отсечения. Исходный текст будет сохранен, но изменить его 

типографские атрибуты будет уже нельзя.  

4. Воспользуйтесь командой меню Layer > Change Layer Content > Levels (Слои > 

Изменить содержимое слоя > Уровни). Эффект отсечения не будет виден до тех пор, пока 

вы не измените слой-дубликат (рис.2.51-2.53).  

 

 
Рис. 2.2.51 - Контур отсечения и корректирующий слой  

 
Рис. 2.52 - Текст, отображенный позади рисунка  

 
Рис. 2.53 - Рисунок, расположенный за текстом  

 

5. Передвиньте серый ползунок средних тонов Input (Ввод) влево к светлым 

полутонам, затем дождитесь изменений на экране. Можно переместить и ползунок Input 

светлых тонов. Кроме того, передвиньте ползунок Output (Вывод) темных тонов вправо, 

чтобы уменьшить контрастность текста.  

6. Нажмите кнопку ОК. Щелкните по слою, содержащему фоновое изображение.  
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Задание 18. Заполнение текста изображением с помощью команды Paste Into  

1. Создайте текстовый слой. Впоследствии его можно будет редактировать, 

преобразовывать в слой фигур или в растровый формат.  

2. Активизируйте слой в том же файле или в другом, содержащем нужное 

изображение.  

3. Воспользуйтесь командой меню Selection > All (Выделить > Все) или создайте 

выделение с помощью мыши.  

4. В меню Edit (Правка) выполните команду Сору (Копировать), которой 

соответствуют сочетания клавиш Ctrl+C.  

5. Выделите изображение, содержащее текстовый слой, а затем, нажав клавишу 

Ctrl, щелкните по имени этого слоя.  

6. В меню Edit (Правка) выполните команду Paste Into (Вставить в) или нажмите 

комбинацию клавиш Ctrl+Shift+V. Автоматически будет создан слой, содержащий маску 

слоя, и изображение станет видимым сквозь маску, форму которой задает текст (рис.2.54, 

2.55).  

 
Рис. 2.54 - Текст, заполненный изображением с помощью команды Paste Into  

 
Рис. 2.55 - Второй слой - исходный. Самый верхний слой был создан после вставки 

изображения в выделенный текст  

 

7. По желанию. Выделив миниатюру нового слоя на палитре Layers (Слои), 

воспользуйтесь инструментом Move (Перемещение), который активизируется при помощи 

клавиши V, а затем переместите вставленное изображение в пределах текста. Теперь 

щелкните между миниатюрой слоя и миниатюрой маски слоя, чтобы связать маску с 

изображением. Пока существует эта связь, нельзя переместить изображение внутри маски. 

(С помощью инструмента Move можно будет перетащить маску и находящееся внутри нее 

изображение одновременно, и, таким образом, станет виден слой, находящийся под 

текстовым.)  
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Задание 19. Создание исчезающего текста  

1. Создайте текст и оставьте его слой активным. Текст можно редактировать и 

преобразовывать в растровый формат.  

2. В нижней части палитры Layers (Слои) щелкните по кнопке Add a mask 

(Добавить маску). Рядом с именем слоя появится миниатюра маски.  

3. Выберите инструмент Gradient (Градиент), нажав клавишу G или комбинацию 

клавиш Shift+G.  

4. На панели опций щелкните по кнопке с треугольной стрелочкой в поле Gradient 

и выберите граничные цвета. Щелкните по кнопке Linear gradient (Линейный градиент), 

выберите режим Normal (Нормальный) и введите значение непрозрачности равное 100% 

(рис.2.56).  

 
Рис. 2.56 - Текстовый слой с маской  

 

5. Удерживая кнопку мыши, перетащите курсор сверху вниз или справа налево в 

окне изображения, по крайне мере, через половину текста. Маска текстового слоя 

заполнится градиентом от-белого-к-черному. Текст будет спрятан в тех местах, где на 

маске присутствует черный цвет (рис.2.57).  

 
Рис. 2.57 - Исчезающий текст  

 

Задания для самостоятельной работы 

 

I. Работы с монтажом изображений 

 
Рис. 2.58 - Примерный вариант монтажа изображений 
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Текст можно изменять при помощи панели инструментов. Для слияния изображений 

необходимо добавить к верхнему слою слой-маску и, используя кисть, убрать лишние 

части.  

  

II. Работа с текстом 

 
Рис.2.59 – Пример работы с текстом 

Для того чтобы ввести текст необходимо:  

1.выбрать инструмент «T» на панели инструментов и ввести нужный текст. 

2. Затем можно начать его редактирование. Можно изменять шрифты, деформировать 

задавать различные цвета и т. д.  

 

III. Работа с цветом 

 
Рис.2.60 – Пример изменения цвета 

 

1.Открываем фотографию, цвет которой нужно изменить. 

2. Используем Быстрое выделение и выделяем только ту область, цвет которой будем 

изменять.  

3. Теперь нажимаем Изображение >Коррекция>Заменить цвет и выбираем пипеткой ту 

область цвет которой мы хотим изменить. 

4. И потом выбираем цвет по вкусу 

IV. Коррекция изображений 
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Рис.2.61 - Устранение эффекта “красных глаз” 

1. Открываем нужную фотографию: 

2. Кликаем правой кнопкой по «пластырю» и выбираем инструмент Red Eye Tool 

(Инструмент красных глаз): 

3. Устанавливаем значения Pupil Size (Размер зрачка) и Darken Amount (Степень 

затемнения) на 25%: 

4. Дальше просто выделяем область вокруг зрачка. 

 

Контрольные вопросы 

1. Как создать новый документ в Photoshop? 

2. Как сделать рамку для изображения? 

3. Как устранить “эффект красных глаз”? 

4. Инструмент Текст. Эффекты для текста. 

5. Перечислите основные операции со слоем. 
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Лабораторная работа №3. Работа в программе Adobe Indesign 

Цель работы: изучение основных правил верстки документа, иллюстраций 

Задачи работы: 

 Верстка текста: основные правила и приемы. 

 Верстка иллюстраций.  

 Оформление документа. 

 Экспорт в формат PDF 

Теоретические положения 

Рабочее пространство программы InDesign включает все элементы, которые 

отображаются при первоначальном открывании или создании документа: панель 

инструментов, монтажный стол и палитры (рис.3.1).  

 
 

Рис.3.1 – А -Панель инструментов. В - Окно документа.  

С - Монтажный стол. D - Палитры 

 

Панель инструментов 

На панели инструментов программы InDesign находятся инструменты для выделения 

объектов, работы с текстом, для рисования и просмотра, а также элементы управления для 

применения и изменения цветных заливок, обводок и градиентов (рис.2.3.2). 

 
Рис.3.2 - Панель инструментов 

 

Если расположить указатель на инструменте выделения ( ), на панели инструментов, 

то выводится подсказка, содержащая имя инструмента и команду быстрого вызова этого 

инструмента. 

Если расположить указатель на инструменте Реn (Перо), нажать и удержать левую 

клавишу мыши - на экране появятся дополнительные инструменты Реn(Перо). Перетащив 
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указатель вправо, и отпустив левую кнопку мыши над одним из дополнительных 

инструментов, можно выбрать его. Всякий инструмент, в нижнем правом углу которого 

отображается треугольник, содержит дополнительные инструменты (рис.3.3). 

 
Рис.3.3 - Пример раскрывающегося списка 

Выбрать инструмент выделения ( ); затем щелкнуть на границе изображения 

небольшого облака в верхнем левом углу на странице 1, чтобы выделить край. 

Выбрать кнопку заливки ( ), чтобы любые выполняемые действия затрагивали 

только центральную часть объекта, оставляя обводку объекта без изменений (рис.3.4). 

 
Рис. 3.4 - Элементы управления цветом 

 

Щелкнуть на кнопке Color (Цвет) ( ), расположенной на панели инструментов и 

объект зальется сплошным черным цветом. Щелкнуть на прямоугольнике Gradient 

(Градиент) ( ) и объект зальется черно-белой градиентной заливкой. Щелкнуть на 

прямоугольнике None  (Отсутствует) ( ), чтобы вернуть объект к исходному состоянию 

без заливки (рис.3.5). 

 
Рис.3.5. - Вариантызаливки 

 

Объект, заполненный сплошным черным цветом (слева), заполненный градиентной 

заливкой (в центре) и без заполнения (справа) 

Отображение свернутой палитры: щелкнуть на вкладке палитры и отобразить или 

скрыть палитру. 

Преобразование свернутой палитры в плавающую палитру: перетащить вкладку 

палитры с боковой стороны программного окна (Windows) или экрана (Mac OS). 

Свертывание палитры во вкладку, расположенную сбоку: щелкнуть на вкладке 

палитры и, не отпуская левой кнопки мыши, переместить палитру к левой или правой 

стороне программного окна (Windows) или экрана (Mac OS). 
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Выбрать кнопку Stroke(Обводка) ( ), с тем чтобы выполняемое редактирование 

затрагивало только обводку объекта. 

Щелкнуть на кнопке Gradient (Градиент) ( ), расположенной на панели инструментов 

- сплошная обводка превратится в градиентную обводку. Щелкнуть на кнопке Color (Цвет) 

( ), чтобы вернуть объекту его исходную обводку. Затем щелкнуть на пустой области 

страницы или на монтажном столе, чтобы снять выделение с изображения облака (рис.3.6). 

 
Рис.3.6 - Заливка с помощью инсрумента Градиент 

Монтажный стол 

Вокруг каждой страницы или разворота в документе находится монтажный стол, на 

котором в процессе создания макета можно хранить объекты, относящиеся к документу. 

Монтажный стол также предоставляет дополнительное пространство вдоль краев 

документа для расширения объектов за пределы страницы. Расширение объектов за 

границы страницы называется «обрезкой в край» (bleed) и используется в тех случаях, 

когда объект должен печататься полностью в границах страницы. 

Чтобы увидеть весь монтажный стол для страниц данного документа, выберите 

команду меню View * Entire Pasteboard(Вид * Весь монтажный стол) (рис.3.6). 

 
Рис.3.6 - Монтажный стол. В. Документ 

Используя инструмент выделения ( ), можно выделить изображение книги на 

рабочем столе и нажмите клавишу Delete. 

Выберать команду меню View   Fit Page in Window (Вид * Целая страница), чтобы 

восстановить окно документа до предыдущего размера. 

Выбрать команду менюFile * Save(Файл * Сохранить). 

 

Задание 1. Просмотр и размещение палитр 

Палитры предоставляют быстрый доступ к часто используемым инструментам и 

функциям в программе InDesign. По умолчанию палитры отображаются 

сгруппированными, но их можно размещать в соответствии с собственными 

предпочтениями. 

1. Выберите команду менюWindow * Workspace * Default(Окно * Рабочее пространство* 

Стандартное), чтобы вернуть палитры в их исходное местоположение. 

2. Щелкните на вкладке палитры Layers(Слои), чтобы вывести данную палитру на экран, 

или воспользуйтесь командой Window *Layers(Окно * Слои) (рис.3.8). 



47 
 

 
Рис.3.8 - Палитры Страницы и Слои 

Задание 2. Использование инструмента Zoom (Масштаб) 

Помимо команд просмотра для увеличения и уменьшения масштаба отображения 

документа можно использовать инструмент Zoom(Масштаб): 

1. Выберите инструмент Zoom (Масштаб) на панели инструментов и расположите его на 

динозавре на странице 1. Обратите внимание, что по центру инструмента 

Zoom(Масштаб) отображается знак «плюс» ( ) (рис.3.9). 

 
Рис.3.9 - Пример использования инструмета Масштаб 

Задание 3. Работа со слоями 

По умолчанию новый документ содержит только один слой (с именем Layer 1). В 

любой момент создания документа слой можно переименовать и добавить дополнительные 

слои. Возможность помещения объектов на разные слои позволяет упорядочивать объекты, 

упрощая их выбор и редактирование. С помощью палитры Layers(Слои) разные слои можно 

выбирать, отображать, редактировать и печатать по отдельности, группами или все вместе. 

Что такое слои? 

Слои можно представить себе как прозрачные листы пленки, сложенные в стопку. 

Если на слое отсутствуют объекты, через этот слой можно видеть любые другие объекты на 

слоях, расположенных ниже (рис.3.10, 3.11): 

 
Рис.3.10 - Палитра Слои 
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Рис.3.11 - Порядок расположения слоев в документе 

1. Щелкните на пустом квадрате, расположенном слева от имени слоя Number. Этот 

квадрат позволяет заблокировать слой, чтобы он был недоступен для редактирования.  

2. Когда слой заблокирован, в палитре отображается значок перечеркнутого карандаша (

) в соответствующем квадрате (рис.3.12). 

 
Рис.3.12 - Пример блокировки слоя 

 

Задание 4. Создание нового документа 

 

При создании нового документа открывается диалог Document Setup (Настройка 

документа). Для создания документа может использоваться набор предварительно 

заданных параметров, или можно воспользоваться данным диалогом для задания 

количества страниц, размера страниц и количества колонок: 

1. Выберите команду меню File * New * Document (Файл * Создать * Документ). 

2. Щелкните на кнопкеОК. 

3. Если палитра Pages (Страницы) еще не открыта, откройте ее, выбрав команду 

меню Window * Pages (Окно * Страницы). 

4. Откроется окно документа, отображающее страницу 1, как указано на палитре 

Pages(Страницы). Палитра Pages(Страницы) разделена на две части. В верхней части 

отображаются значки мастер-страниц. В нижней половине отображаются значки 

страниц документа. В данном документе мастер-страницы представлены для 

двухстраничных разворотов (рис.3.13). 
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Рис.3.13 - А. Значок мастер-страниц.  

        В. Значок страницы документа 

 

Задание 5. Создание мастер-страниц для нижних колонтитулов 

 

Сетка, добавленная на мастер-страницу, необходима для большинства страниц 

документа. Помимо обычной сетки на большинстве страниц документа необходимо 

располагать одинаковый текст вдоль верха (верхний колонтитул) или одинаковый текст 

вдоль нижней части страниц (нижний колонтитул). На некоторых из этих страниц 

документа требуется согласованное размещение текста и графики. Чтобы выполнить эти 

разные требования к макетам страниц, можно создать разные мастер-страницы для страниц, 

на которых необходимо разместить нижний колонтитул, и еще один набор мастер-страниц, 

на которых находятся фреймы заполнителя для текста и графики. 

Каждую мастер-страницу можно создавать независимо от других или можно 

создавать мастер-страницы на основе других мастер-страниц. При создании мастер-страниц 

на основе других мастер-страниц любые изменения родительских мастер-страниц будут 

появляться и на дочерних мастер-страницах (рис.3.14): 

 

 

Рис 3.14 - А. Мастер-страница 

A-Grid. В. Мастер-страница 

B-Footer. С. Мастер-страница 

C-Placeholder. D. Страницы 

документа, основанные на 

мастер-странице B-Footer. Е. 

Страницы документа, 

основанные на мастер-

странице C-Placeholder 

1. В меню палитры Pages (Страницы) выберите команду New Master (Новая мастер-

страница) (рис.3.15). 

 
Рис.3.15 - Новая мастер-страница 
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2. Введите в полеName(Имя) имяFooter. 

3. В открывающемся списке Based on Master (На основе мастер-страницы ...) выберите A-

Grid и щелкните на кнопке ОК (рис.3.16). 

 
Рис.3.16 - А. Имя мастер-страницы. В. Буквы «А» показывают, что мастер-страницы B-

Master основаны на мастер-страницах A-Master 

 

Задание 6. Создание обтекания текста вокруг графики 

 

Имеется возможность настройки обтекания текста вокруг фрейма объекта или вокруг 

самого объекта.  

Для точного позиционирования фрейма можно также использовать клавиши со 

стрелками или можно ввести точные координаты позиции на 

палитре Transform (Трансформация) (рис.3.17): 

 
Рис.3.17 - Исходный документ 

 

1. Выберите команду меню Window * Туре & Tables * Text Wrap (Окно * Текст и таблицы 

* Обтекание текста), чтобы открыть палитруText Wrap (Обтекание текста), и выберите 

второй режим обтекания, в котором текст обтекает вокруг ограничивающего контура, а 

не вокруг звездообразного фрейма (рис.3.18). 
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Рис.3.18 - Текст, обтекающий вокруг ограничивающего контура 

 

2. Затем выберите третий режим обтекания, чтобы текст обтекал вокруг контура фрейма 

рисунка, а не вокруг ограничивающего контура. Щелкните на пустой области, чтобы 

снять выделение со всех объектов (рис.3.19). 

 
Рис.3.19 - Текст, обтекающий содержимое 

 

3. Чтобы сетка отображалась в окне документа, выберите команду меню View * Show 

Baseline Grid (Вид * Показать сетку базовых линий). Сетка не будет видна, так как 

масштаб отображения документа меньше порога видимости для сетки. Выберите в 

меню масштаба отображения, расположенном в нижнем левом углу окна документа, 

значение 100% - теперь сетка видна на экране (рис.3.20). 

 
Рис.3.20 - Сетка базовых линий 

 

4. Щелкните на вкладке палитры Paragraph (Абзац) или выберите команду меню Туре * 

Paragraph(Ввод * Абзац), чтобы сделать палитру видимой (рис.3.21). 

 
Рис.3.21. Палитры Paragraph (Абзац) 
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5. Не отменяя выбор инструмента Туре (Ввод), посредством щелчка установите точку 

ввода где-нибудь в первом абзаце на развороте и затем выберите команду меню Edit * 

Select All(Правка * Выделить все), чтобы выделить весь текст в основном рассказе. 

6. На палитре Paragraph (Абзац) щелкните на кнопке Align to Baseline Grid (Выравнивание 

по сетке базовых линий). Текст сдвинется так, чтобы базовые линии букв совпадали с 

линиями сетки (рис.3.22). 

 
Рис. 3.22.Вид страницы до и после выравнивания текста по сетке базовых линий 

 

7. На палитре Paragraph (Абзац) щелкните на кнопке Align to Baseline Grid (Выравнивание 

по сетке базовых линий). Поскольку данный текст отформатирован с интерлиньяжем 

18 пунктов, не равным значению интерлиньяжа сетки базовых линий, которое 

составляет 14pt или 1р2, выравнивание по сетке приводит к растягиванию текста по 

вертикали и размещению строк на каждой второй линии сетки (используется 

интерлиньяж 28 пунктов) (рис.3.23). 

 
Рис. 3.23 - Вид страницы до и после выравнивания врезки по сетке базовых линий 

 

Задание 7. Применение к тексту градиента 

 

В программе InDesign очень просто применять градиенты к заливке и обводке 

символов текста. Градиенты можно применить ко всему текстовому фрейму или к разным 

диапазонам символов внутри фрейма:  

1. Щелкните на вкладке палитры Swatches(Образцы цвета) или выберите команду меню 

Window * Swatches (Окно * Образцы цвета), чтобы сделать палитру видимой (рис.3.24): 
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Рис.3.24 - Палитра Swatches(Образцы цвета) 

2. Убедитесь, что по-прежнему выбран инструмент ввода ( ). Щелкните в тексте врезки 

на странице 2 и затем выделите весь текст абзаца. 

3. Выберите кнопку заливки ( ) на панели инструментов и затем выберите образец 

градиента текста на палитре Swatches (Образцы цвета) (возможно, потребуется 

прокрутить окно палитры). Чтобы просмотреть градиент, выберите команду меню Edit 

* Deselect All(Правка * Отменить все выделение) (рис.3.25): 

 
Рис.3.25 - Применение Градиента к тексту 

 

Задание 8. Создание буквицы 

1. Используя инструмент ввода ( ), посредством щелчка вставьте точку ввода. 

2. На палитре Paragraph (Абзац) введите в поле Drop Cap Number of Lines (Количество 

строк для буквицы) ( ) значение 3, чтобы буквы углубились в текст на три строки. 

Затем введите в поле Drop Cap One or More Characters (Одна или несколько буквиц) (

), чтобы сделать буквицами три буквы. Нажмите клавишу Enter (рис.3.26). 

 
Рис.3.26 - Вид страницы до и после установки буквиц 

Задание 9. Создание PDF-документа  

 

1. Выберите в меню команду File * Export (Файл * Экспорт). 

2. В появившемся диалоге Export PDF (Экспорт в формат PDF) выберите при 

необходимости в открывающемся списке Save as type(Тип сохраняемого документа) 

формат Adobe PDF и откройте нужную папку. 
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3. Присвойте сохраняемому файлу имя.pdf. 

4. Щелкните на кнопке Save (Сохранить). 

5. В верхней части открывшегося диалога Export PDF (Экспорт в формат PDF) выберите в 

открывающемся списке Preset(Предварительные настройки) значение Screen (Экран) 

(рис.3.27). 

 
Рис.3.27 - Диалог Export PDF 

 

Задание для самостоятельной работы 

Создание сказки в  Adobe InDesign 

 Перед началом работы нужно открыть новый документ. Для вставки текста 

необходимо выбрать нужный инструмент, выделить текстовый фрейм, где будет 

располагаться текст, и вставить его из буфера обмена. Настройки текста можно 

задать при помощи ниспадающего меню «Текст». 

 Для вставки картинок надо создать графический фрейм и, выделив его, выполнить 

вставку картинки. Добавление номеров страниц, имени автора на каждой странице 

осуществляется при помощи колонтитулов. Для настройки колонтитулов 

используется панель «Страницы», на ней мы работаем над шаблоном.    

 При необходимости редактировать установленный шаблон, надо на панели 

«Страницы» открыть контекстное меню и выбрать указанный ниже элемент. В 

завершении выбираем формат, в котором будет сохранен документ. В моем случае 

это PDF. 

Контрольные вопросы 

1. Как осуществляется выбор инструментов в программе InDesign? 

2. В чем заключаются преимущества добавления объектов на мастер-страницы? 

3. Как просмотреть сетку базовых линий? 

4. Для чего нужно преобразовывать документы программы InDesign в формат Adobe 

PDF? 

5. Все ли файлы формата Adobe PDF, создаваемые с помощью программы Adobe 

InDesign CS2, являются одинаковыми? 
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Лабораторная работа №4. Создание видеоролика в программе Adobe 

Premiere Pro 

Цель работы: изучение основных правил верстки документа, иллюстраций 

Задачи работы: 

 Изучение основ интерфейса программы и базовых принципов её работы. 

Теоретические положения 

 Освоение процесса монтажа на примере простого проекта 

 Создание и анимация титров. Изучение штатного титровальщика и различных 

способов анимации титров 

Теоретические положения 

Программа Adobe Premiere позволяет производить нелинейный монтаж. Монтаж 

фильма в программе происходит в рамках проекта, который создает сама программа. 

Проекты имеют расширение *.prproj.  

В проекте хранятся ссылки на исходные файлы (их принято называть исходниками), 

на смонтированные фрагменты видео и звука, а также на применяемые к ним спецэффекты. 

Важно не забывать, что исходники в проекте представлены в виде ссылок на их имя и адрес 

на диске, поэтому при изменении одного из этих параметров Adobe Premiere не сможет 

автоматически найти требуемый файл и попросит пользователя указать новый путь к нему.  

При запуске программы появится диалоговое окно, предлагающее вам выбрать 

работу с новым проектом (New project) или открыть уже существующий проект (Open 

project). Здесь же содержится ссылка на проекты, находившиеся недавно в работе (Recent 

project) (рис.4.1). 

 
Рис. 4.1 -  Окно приветствия 

Интерфейс программы (рис.4.2) 

 
Рис. 4.2 - Интерфейс программы Adobe Premiere 

 

 В начале работы, до загрузки необходимых вам элементов будущего фильма, все 

окна пусты. 

 В программе существует три основных окна: "Проект" (Project), "Программа" 

(Program) и "Монтажный стол" (Timeline). Все остальные окна и вкладки являются 

дополнительными. Есть еще панели инструментов, которые мы будем рассматривать 

последовательно, по мере освоения нового материала. 
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 Над окнами можно производить все привычные операции: перемещать, изменять 

размер. Окно может быть активным и неактивным. 

 Работать можно только в активном окне. Для этого нужно щелкнуть левой 

кнопкой мыши на нужное вам окно, и оно станет подсвечиваться оранжевым контуром. 

 Если на экране отсутствует нужное вам окно или палитра, то нужно обратиться 

к меню Window и выбрать пункт меню с названием необходимого окна. 

 Каждое окно внутри себя имеет собственное меню, настраивающее работу 

каждого окна в отдельности. Вход в меню находится в верхней правой части окна и 

обозначается круглой кнопкой с треугольником внутри. 

Окно Проект (Project) (рис.2.4.3) 

 Окно предназначено для работы с файлами-исходниками. Здесь они 

отображаются после помещения (импорта) их в проект и составляют так называемую 

"библиотеку исходников". 

 
Рис. 4.3 - Окно "Проект" 

 

 В верхней части окна отображается выбранный в данный момент исходник и его 

основные параметры. Рядом с миниатюрой есть кнопка управления просмотром — 

"Начать/Остановить воспроизведение". 

 В средней части расположен список файлов и папок, которые были загружены в 

проект в качестве исходного материала. Каждый тип файла имеет свою цветовую метку. 

Исходники можно перемещать по папкам, удалять, переименовывать — так же, как и 

обычные файлы. Для этого существует графическое меню в левой нижней части окна и 

всплывающее меню окна "Проект" (рис.4.4). 

 
Рис. 4.4 - Меню окна "Проект" 

 

 "Новая корзина" (New Bin) — создать новую корзину. Термин "корзина" 

соответствует термину "папка", принятому в операционных системах Microsoft Windows. 

Если щелкнуть по этой кнопке несколько раз, то каждая последующая корзина-папка 

автоматически вкладывается в предыдущую. 
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 "Переименовать" (Rename) — переименовать файл. 

 "'Удалить" (Delete) — удалить файл или папку. При этом файл или папка 

остаются на жестком диске. 

 "Автоэпизод" (Automate to Sequence) — позволяет автоматически перемещать 

исходные файлы на монтажный стол в требуемой последовательности. 

 "Найти" (Find) — найти файл или папку. 

 "Вид" (View) — активирует представления клипов в виде списка или иконок. 

 "Эскизы" (Thumbnails) — активирует представление клипов в виде миниатюр. 

 "Очистить" (Clean Up) — очистить содержимое окна. 

 "Обновить" (Refresh) — обновить содержимое окна. 

 "Правка столбцов" (Edit Columns) — редактирование списка колонок с 

атрибутами файла. Выберите нужный вам параметр и щелкните кнопку "Добавить" (Add). 

 

Окно "Источник" (Source) 

Дважды щелкнув на название клипа, можно просмотреть его содержимое в 

отдельном окне "Источник" (Source). А можно просто мышкой перетащить клип из окна 

"Проект" (Project) в окно "Источник" (Source). 

 В окне "Источник" (Source) может находиться сразу несколько клипов. Чтобы 

просмотреть их и выбрать нужный, нужно щелкнуть на значок выпадающего списка, 

расположенный рядом с названием окна. Используя команду Close (Закрыть) или Close All 

(Закрыть всё), можно очистить окно. 

 Окно служит также для подготовки файла к монтажу. Для этого сначала нужно 

обозначить с помощью Меню маркеров начальную (начальный маркер) и конечную 

(конечный маркер) точки фрагмента. Затем, выбрав команду "Вставка" (Insert) или 

"Наложение" (Overlay), переместить фрагмент в окно монтажа. Файл будет помещен на ту 

дорожку, которая в данный момент активна в окне "Монтажный стол" (Timeline) (рис.4.5). 

 
Рис. 4.5 - Окно "Источник 

 

Команда "Вставка" обеспечивает помещение фрагмента в последовательность, при 

этом все клипы, находящиеся справа от вставки, будут сдвинуты вправо на время, равное 

длине помещаемого фрагмента. Команда "Наложение" помещает клип на соответствующую 

дорожку, не изменяя при этом общей длины всего фильма. Поскольку панель инструментов 

окна "Источник" (Source) во многом совпадает с окном "Программа" (Program), более 

подробно речь об этом пойдет на следующем уроке. 

 

Окно "Программа" (Program) 
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Служит для просмотра находящегося в монтаже или уже готового материала (рис.4.6).  

 
Рис. 4.6 - Окно "Программа 

 

Задание 1. Знакомство с окном "Монтажный стол" (Timeline) 

 

Окно, служащее для визуального монтажа клипов. Видео- и аудиоклипы размещаются 

по соответствующим дорожкам вдоль временной шкалы (линейки времени) в нужной 

последовательности. Поместить файлы на монтажный стол можно тремя способами: 

1. Перетащить нужный файл мышкой, удерживая нажатой левую кнопку, из окон 

"Проект" (Project), "Программа" (Program), "Источник" (Source). 

2. Автоматически из окна "Проект" (Project), используя команду "Автоэпизод" 

(Automate to Sequence). 

3. Автоматически из окна "Программа" (Program), используя команды "Вставка" 

(Insert) или "Наложение" (Overlay). 

Монтажный стол служит также для создания переходов между клипами, создания 

видео- и аудиоэффектов (рис.4.7): 

 
Рис. 4.7 - Монтажный стол 

 

1. Видеофайлы помещаются на дорожки Video 1, 2, 3… 

2. Аудиофайлы размещаются на дорожках Audio 1, 2, 3… 

3. При перемещении исходников на монтажный стол программа автоматическую 

создает так называемую рабочую область, для которой просчитывается предварительный 

просмотр. Запустить предварительный просмотр можно, нажав клавишу Enter или 

обратившись к пункту меню Эпизод (Sequence) и выбрав пункт меню "Сглаживание 

рабочей области" (Render Work Area). 

o Если область предварительного просмотра выделена красной полосой, это значит, 

что программе необходимо создать файл предварительного просмотра (запускаются так 

называемые процессы рендеринга или компиляции). Для этого нужно нажать клавишу 

Enter. 
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o Если область предварительного просмотра выделена зеленым цветом, это значит, 

что компиляции не требуется и программа готова воспроизвести файл в режиме реального 

времени. 

o Можно менять область предварительного просмотра по своему желанию. Для 

этого нужно передвигать саму полосу за центр либо двигать в нужную сторону маркеры по 

краям. Двойной щелчок на полосе рабочей области автоматически увеличивает ее таким 

образом, что видна вся последовательность файлов. 

4. Текущее положение курсора отмечается как вертикальной линией на дорожке, так 

и в числовом формате (временной код) в верхнем левом углу в формате часы:минуты:се-

кунды:кадры (например, 00:02:32:15). Щелкнув левой кнопкой мыши на табло с указанием 

текущего положения курсора, можно ввести с клавиатуры нужный временной код, и тогда 

курсор переместится в указанное место. 

5. В левом нижнем углу можно настроить масштаб отображения линейки времени в 

зависимости от длительности фильма и конкретных задач, потянув в нужную сторону за 

бегунок или нажав кнопки увеличения или уменьшения масштаба отображения. 

6. Окно содержит одну или несколько последовательностей (Sequence). Каждая 

последовательность имеет свой номер и отображается в виде вкладок окна "Монтажный 

стол" (Timeline). 

 

Задание 2. Импорт файлов 

 

Для помещения исходных файлов в проект необходимо воспользоваться командой 

"Импорт" (Import) пункта меню "Файл" (File) (рис.4.8). Чтобы избежать возникновения 

возможных проблем, лучше скопировать все исходники в одну папку и на протяжении всей 

работы над проектом не перемещать их в другое место на диске и не переименовывать. 

Такое требование связано с тем, что Adobe Premiere не загружает в проект сами исходники, 

а хранит только ссылки на них. В противном случае объем проекта был бы чрезмерно 

большим. 

 
Рис. 4.8 - Команда "Импорт" 

 В диалоговом окне "Импорт" (Import) можно выбрать один или несколько 

необходимых файлов. Если требуется выбрать некую последовательность, то это 

можно сделать,удерживая клавишу Shift и выбирая левой кнопкой мыши первый и 

последний файлы последовательности. Если требуется выбрать насколько 

разрозненных файлов, то для этого удерживают нажатой клавишу Ctrl. 

 Можно загрузить в проект папку целиком. Для этого воспользуйтесь кнопкой Import 

Folder (Импортировать папку). 

 После загрузки файлов и папок в проект они появятся в окне "Проект" (Project). 



60 
 

 

Задание 3. Экспорт фильма 

 

Смонтированный фильм может быть записан на пленку, CD- или DVD-диск или 

просто перезаписан в один из общепринятых универсальных видеоформатов. Для этого 

необходимо войти в меню Файл (File), выбрать пункт меню "Экспорт" а "Фильм" (Export а 

Movie). Чтобы команда "Экспорт" (Export) стала доступна, необходимо, чтобы окно 

"Монтажный стол" (Timeline) было активным. 

 Для просмотра параметров готового фильма нужно выбрать в диалоге "Экспорт" 

(Export) кнопку Settings ("Установки"), после чего откроется окно Exliort Settings 

("Установки экспорта"). В закладках "Общие", "Видео" и "Аудио" можно выбрать нужные 

параметры итогового фильма. 

 Формат будущего файла. Поскольку мы работаем с цифровым видео, то 

выбираем формат DV 

 Какая область окна "Монтажный стол" (Timeline) включается в экспорт (вся 

последовательность (Entire Clip) или только рабочая область (In to Out)). 

 Режим воспроизведения видео (телевизионный формат (в нашем случае – PAL), 

размер кадра (Frame Size), количество кадров (Frame Rate)). 

Очень удобно производить экспорт через специальную встроенную программу 

Adobe Media Encoder (меню "Файл" (File)). Выбирая окончательный формат фильма, здесь 

можно настраивать практически любые его характеристики (рис.4.9, 4.10). 

 Окончательный формат фильма (MPEG1, MPEG2, Micromedia Flash Video, Quick 

Time, Real Media). Обратите внимание, что в зависимости от выбранного вами формата 

изменяются такие ключевые характеристики изображения, как размер кадра, частота 

кадров, частота звука, используемая компрессия. Общий обзор установок экспорта 

находится под заголовком Summary. 

 "Кодек" (Video Codec) для сжатия фильма, который зависит от выбранного 

первоначально формата фильма. Использование данного инструмента позволит записать 

полуторачасовой фильм на один компакт-диск без существенной потери качества. 

 Битрейт (Bitrate Mode) – количество информации, выделяемой для записи звука 

и видео. Чем больше величина битрейта, тем лучше качество фильма и больше его размер. 

Предпочтительно использовать параметр Variable Unconstrained (Переменный битрейт). В 

этом случае величина битрейта изменяется в зависимости от качества картинки. 

 Для того чтобы статическое изображение в кадре не искажалось и отображалось 

полностью, необходимо выделить нужный файл на "Монтажном столе" (Timeline), нажать 

левую кнопку мыши и установить флажок у параметра Scale to frame size. 
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Рис. 4.9 - Выбранный исходник неполностью отображается в окне "Программа" 

 

 
Рис. 4.10 - Выбранный исходник полностью отображается в окне "Программа" 

 

Задание 4. Просмотр находящегося в монтаже или уже готового материала 

 

Кадр, отображаемый в окне, соответствует положению курсора в окне "Монтажный 

стол" (Timeline) (рис.4.11). 
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Рис. 4.11 - Окно "Программа" 

 

1. Установка входящего маркера. Служит для маркировки начала фильма или 

какого-либо фрагмента. 

2. Установка выходного маркера. Служит для маркировки окончания фильма 

или какого-либо фрагмента. 

3. Установка ненумерованного маркера. Может служить для отметки 

необходимых фрагментов фильма. Обратите внимание, что все маркеры, установленные в 

окне "Программа" (Program), автоматически переносятся в окно "Монтажный стол" 

(Timeline). Если навести курсор мыши на значок ненумерованного маркера в окнах 

"Программа" (Program) или "Монтажный стол" (Timeline) и затем щелкнуть правой кнопкой 

мыши, появится выпадающее меню маркеров (рис.4.12). 

4. Переместить курсор к входному маркеру. Служит для быстрого перемещения 

к началу фильма или к фрагменту, отмеченному входным маркером. 

 
Рис. 4.12 - Меню маркеров окна "Программа" 

 

5. Переместить курсор к выходному маркеру. Служит для быстрого 

перемещения в конец фильма или фрагменту, отмеченному выходным маркером. 

6. Проиграть клип от входящего до выходящего маркера. 

7. Переход к предыдущей точке редактирования от текущей позиции курсора. 

8. Переход к предыдущему кадру. 

9. Начать воспроизведение фрагмента от входного маркера. Это действие 

запускается также нажатием клавиши "пробел". После начала воспроизведения эта же 

кнопка (или клавиша "пробел") повторным нажатием обеспечивает остановку 

воспроизведения. 

10. Перейти к следующему кадру. 

11. Переход к следующей точке редактирования от текущей позиции курсора. 

12. Ползунковый регулятор, позволяющий перемещаться по фильму с разной 

скоростью. 

13. Полоса протяжки. Служит для перемещения по всей длине клипа. 

14. Циклическое воспроизведение фильма от начального до конечного маркера. 

15. На миниатюре кадра появляются так называемые безопасные границы для 

действий и надписей. Все, что находится внутри этих границ, будет гарантированно 
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отображаться на экране. Рамки безопасных границ предназначены только для удобства 

пользователя и не будут отображаться в итоговом фильме. 

16. Нажав на маленький треугольник в нижнем правом углу кнопки, получите 

выпадающее меню для настройки изображения в окне "Программа" (Program). Верхняя 

часть окна предназначена для отображения параметров прозрачности, яркости и цветовой 

модели изображения. Средняя часть определяет качество видео, отображаемого в окне 

"Программа" (Program), - наивысшее, черновое и динамическое (изменяющееся в 

зависимости от характеристики видео). Параметр Playback Settings позволяет настроить 

параллельное с окном "Программа" (Program) отображение картинки на внешнем 

устройстве. 

17. Удаление клипа из окна "Монтажный стол" (Timeline) без изменения общей 

длины всей последовательности. 

18. Удаление клипа из окна "Монтажный стол" (Timeline) со сдвигом всей 

остальной последовательности влево. 

19. Включает режим тримминга. Этот режим позволяет визуально произвести 

стыковку кадров двух находящихся рядом фрагментов. 

 

Задание 5. Работа в окне "Монтажный стол" (Timeline) (рис.4.13) 

 

 
Рис. 4.13 - Окно "Монтажный стол" 

Окно "Монтажный стол" (Timeline) связано с окном "Программа" (Program) 

отображением текущего кадра фильма. В окне "Монтажный стол" (Timeline) курсор 

находится на том кадре, чье отображение в данный момент идет в окне "Программа" 

(Program). 

Дорожки (или треки) окна Монтажный стол (Timeline) идут вдоль шкалы времени. 

Дорожки предназначены для размещения изображений (видеодорожки) и звуков 

(аудиодорожки). В Adobe Premiere может быть бесконечное число видео- и аудиодорожек. 

Клипы, расположенные на треке с более высоким номером, накладываются на 

нижележащий трек. Таким образом, треки представляют собой слои, для каждого из 

которых (кроме самого первого, нижнего) может быть настроен необходимый режим 

прозрачности. Чтобы добавить дорожку, надо зайти в пункт меню "Последовательность" 

(Sequence) и выбрать команду "Добавить дорожку" (Add track). Команда добавления или 

удаления трека также появится, если навести курсор мыши на название дорожки и нажать 
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правую кнопку, а затем в выпадающем меню выбрать команду "Добавить дорожку" (Add 

track). В появившемся диалоговом окне нужно будет указать количество добавляемых 

дорожек. Для удаления дорожек выберите из меню "Последовательность" (Sequence) или из 

выпадающего меню команду "Удалить дорожки" (Delete Tracks) и укажите количество 

дорожек для удаления. Помните, что вместе с дорожкой удаляется и все ее содержимое. 

Для переименования дорожки рядом с ее названием (например, Video2) щелкните 

правой кнопки мыши и из выпадающего меню выберите команду "Переименовать" 

(Rename). 

В заголовке каждой дорожки есть несколько параметров, позволяющих настроить вид 

каждой из них: 

1. Включения или выключения трека (Toggle track output). Если трек "включен", то 

кнопка содержит изображение глаза (для видеодорожек) или динамика (для аудиодорожек). 

Если трек включен, то это означает, что его содержимое включено в фильм, если выключен 

- исключено из фильма. 

2. Режим открытия или закрытия трека (Toggle track lock). Если трек открыт, то есть 

доступен для редактирования, то кнопка не содержит никакого изображения - она пуста. 

Если трек закрыт для редактирования, то в поле кнопки отображается замок, а сама 

дорожка отмечается штриховкой. В этом случае никаких правок в клипы на дорожке 

вносить нельзя, но сама она включается в предварительный просмотр. 

3. Кнопка для установки способа отображения видеофрагментов на треке (Set 

display style). Для установки требуемого стиля нужно нажать на меленький треугольник, 

расположенный в нижнем правом углу кнопки (рис.4.14). 

 
Рис. 2.14 - Способ отображения файлов-исходников  

в окне монтажа 

4. Для аудиодорожек возможно отображение графика громкости (Show waveform) 

или просто имени файла. 

5. Показать ключевые кадры (Show keyframes). Нажав на маленький треугольник, 

расположенный в нижнем правом углу кнопки, получаем выпадающее меню (рис.4.15). 
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Рис. 4.15 - Расстановка ключевых кадров в окне монтажа 

6. Развернуть или свернуть трек (Collapse/Expand Тrack). Белый треугольник рядом с 

названием трека, развернутый вправо, означает свернутый трек, треугольник, 

направленный вниз, - развернутый трек. 

7. Расстановка/удаление ключевых кадров (Add/Remove Keyframes). Чтобы задать 

ключевой кадр, нужно установить курсор в нужное место трека и нажать на белую круглую 

кнопку "Расстановка/Удаление ключевых кадров" (Add/Remove Keyframes). На дорожке 

появится белый круг, обозначающий ключевой кадр. Белые треугольные кнопки, 

расположенные с двух сторон от центральной, позволяют перемещаться по ключевым 

кадрам. 

При монтаже одно из самых востребованных действий над клипами - это так 

называемая обрезка клипов, когда из большого клипа вам нужно выбрать небольшой 

фрагмент и поместить его в окно "Монтажный стол" (Timeline) для последующей работы. В 

этом случае при просмотре исходного файла в окне "Источник" (Source) отмечается 

входным маркером начало фрагмента и выходным маркером - его окончание. Затем 

выделенный фрагмент перемещаете мышкой на дорожку в окно "Монтажный стол" 

(Timeline) или используете команды "Вставка" (Insert) или "Наложение" (Overlay) окна 

"Источник" (Source). В дальнейшем можно менять начало или конец выбранного фрагмента 

непосредственно в окне "Монтажный стол" (Timeline). 

 
Рис. 4.16 - Инструменты монтажа 

 Инструмент выбора (Selection Tool) позволяет выделить один клип, трек, сделать 

активным какое-либо из окон. 
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 Инструмент выбора трека (Track Select Tool) позволяет выбрать все клипы на 

дорожке, которые расположены правее текущего положения курсора. 

 Инструмент монтажа со смещением (Ripple Edit Tool). В этом случае при вставке 

или удалении клипа происходит изменение длительности всей последовательности в 

большую или меньшую сторону на величину, равную длительности помещенного или 

удаленного клипа. 

 Инструмент монтажа c наложением (Rolling Edit Tool). При вставке клипа 

методом наложения общая длительность всей последовательности сохраняется, однако 

изменяется граница между клипами за счет наложения одного клипа на другой. 

 Инструмент масштабирования клипов (Rate Stretch Tool) изменяет длительность 

клипов за счет скорости воспроизведения. Следует осторожно применять этот инструмент 

для редактирования, чтобы избежать потери качества исходного материала. 

 Инструмент разрезания клипов (Razor Tool) делит один клип на два. 

 Инструмент монтажа с прокруткой (Slip Tool) изменяет входной и выходной 

маркеры редактируемого клипа. Длительность самого клипа при этом не изменяется. 

 Инструмент монтажа с совмещением (Slide Tool) изменяет входной и выходной 

маркеры за счет наложения на соседние клипы. 

 Инструмент "Перо" (Pen Tool). 

 Инструмент перемещения (Hand Tool) по рабочей области окна "Монтажный 

стол" (Timeline). 

 Инструмент изменения масштаба временной шкалы (Zoom Tool). При 

одновременном нажатии кнопки Alt уменьшает масштаб. 

Часто бывает необходимо редактировать отдельно видеоряд и звуковую дорожку, что 

не всегда возможно, если видео- и аудиофайлы связаны между собой (в окне "Линия 

времени" (Timeline) они отображаются одинаковым цветом). Чтобы разъединить звук и 

видео, необходимо выделить требуемые файлы, выбрать меню "Клип" (Clip) и выбрать 

команду Unlink. 

 

Задание 6. Работа с видеопереходами 

 

Понятие перехода 

Переходом в программе Adobe Premiere называется особый эффект, который 

применяется при смене одного изображения (или звукового фрагмента) на другой. До 

сегодняшнего урока мы монтировали клипы "в стык": то есть, как только заканчивался 

один видеофрагмент, сразу начинался другой. Довольно часто можно увидеть, как одно 

изображение плавно переходит в другое либо смена картинки происходит за счет эффекта 

перелистывания страницы, или "шторок", или вытеснения и т. д. Программа Adobe Premiere 

предлагает несколько десятков разных переходов. Вкладка окна, содержащего переходы, 

называется "Эффекты" (Effects). Переходы здесь представлены двумя типами: папка 

"Видеопереходы" (Video Transitions) и папка "Аудиопереходы" (Audio Transitions). 

Рассмотрим сначала переходы, предназначенные для монтажа видеофайлов. Для этого 

нужно выбрать список "Видеопереходы" (Video Transitions). 
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При нажатии на белый треугольник рядом с названием "Видеопереходы" (Video 

Transitions) появится список предлагаемых программой видеопереходов. Они разложены в 

папки по видам (рис.4.17). 

 
Рис. 4.17 - Папка видеопереходов 

 

 

Рассмотрим основные виды переходов: 

1. 3D Motion — создает пространственный эффект смены одного 

изображения другим. Например, вот так выглядит переход Flip Over: 

 

 

 
 

 
 

Первый 

фрагмент 

Начало перехода Конец перехода Второй 

фрагмент 

2. Dissolve — группа переходов, обеспечивающих плавное растворение 

одного изображения и появление второго. Переход Cross Dissolve будет выглядеть 

так: 

 
  

 

 

Первый фрагмент Переход Второй фрагмент 

3. GPU Transitions — группа переходов, обеспечивающих переход от 

одного фрагмента к другому при помощи создания эффекта анимации. Рассмотрим 

эту группу на примере перехода Sphere: 
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Первый 

фрагмент 

Начало перехода Конец перехода Второй 

фрагмент 

4. Iris — группа переходов, где на фоне первого клипа появляется некая 

врезка, через которую проступает изображение второго фрагмента. Например, так 

работает переход Iris Diamond: 

5. Map — группа эффектов, работающих с цветностью и яркостью двух 

фрагментов. 

 

 

 

 

 

 

 

6. Page Peel — группа переходов, создающих эффект переворачивания 

страницы с одного фрагмента на другой. Эффект Page Peel: 

 
 

 

 
 

Первый фрагмент Переход Второй фрагмент 

7. Slide — группа переходов, имитирующих смену слайдов. Эффект Push: 

 
 

 
 

 
 

 
 

Первый 

фрагмент 

Начало перехода Конец перехода Второй фрагмент 

8. Special Effects — группа эффектов, служащих для задания параметров 

наложения одного видеофрагмента на другой. 

9. Stretch — группа эффектов, обеспечивающих переход за счет 

искажения картинки. Например, вот так работает переход Funnel: 

 

 

 
 

Первый фрагмент Переход Второй фрагмент 
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Первый 

фрагмент 

Начало перехода Конец перехода Второй фрагмент 

10. Wipe — группа переходов, создающих эффект вытеснения первого 

фрагмента вторым. Например, переход Pinwheel: 

  
 

 
 

Первый фрагмент Переход Второй 

фрагмент 

11. Zoom — группа эффектов, применяющих эффект масштабирования 

при смене фрагментов. Рассмотрим один из эффектов этой группы Zoom Boxes: 

 
  

 

 
 

Первый фрагмент Переход Второй 

фрагмент 

Более подробную информацию о каждом из переходов можно найти в 

соответствующем разделе помощи. 

 

Аудиопереходы 

Переходы, которые используются для связи аудиофрагментов фильма, расположены в 

папке "Аудиопереходы" (Audio Transitions) (рис.4.18). 
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Рис. 4.18 - Папка "Аудиопереходы" 

 

В папке "Аудиопереходы" (Audio Transitions) находится только одна папка 

Перекрестное затухание (Crossfade), которая содержит два аудиоперехода. 

"Постоянное увеличение" (Constant Gain) позволяет плавно перейти от одного 

аудиоф-рагмента к другому без изменения громкости звука. 

"Постоянное усиление" (Constant Power) сначала начинает уменьшать громкость 

первого фрагмента так, что к концу перехода он вовсе перестает звучать. Второй фрагмент 

в начале перехода не слышен вовсе, но по мере затухания первого фрагмента громкость 

второго увеличивается и к концу перехода он начинает звучать в полном объеме. 

 

Настройки переходов 

Чтобы использовать переход при монтаже, нужно щелкнуть мышью на названии 

требуемого перехода во вкладке "Видеопереходы" (Video Transitions) или "Аудиопереходы" 

(Audio Transitions) и, удерживая нажатой левую кнопку мыши, перетащить переход в окно 

"Монтажный стол" (Timeline). При этом фрагменты, между которыми предполагается 

использование перехода, лучше размещать на разных дорожках (рис.4.19, 4.20). 

 
Рис. 4.19 - Размещение исходников в окне монтажа для создания между ними перехода 

 
Рис. 4.20 - Добавление перехода 

 

При таком размещении клипов на дорожках важно помнить, что треки воспроизводят 

содержимое по принципу слоеного пирога, то есть границы двух расположенных на 

соседних дорожках клипов должны перекрываться. И тогда переход, начинающийся на 

последних секундах первого фрагмента, одновременно будет по временной шкале 

совпадать с первыми секундами второго клипа. В противном случае в начале или конце 

перехода вместо требуемого исходного или конечного изображения можно получить 

черный экран. 

В программе Adobe Premiere Pro CS3 можно применять и более простую схему 

расположения исходников и перехода между ними: все это можно расположить на одной 

дорожке. 
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При этом переход накладывается на стык между двумя соседними фрагментами. 

Такой тип расположения не всегда удобен, когда уже после расстановки переходов 

требуется изменить длительность исходных файлов (рис.4.21). 

 
Рис.4.21 - Использование одной дорожки для перехода 

 

Чтобы посмотреть, как работает переход, необходимо поместить его на любую 

дорожку "Монтажного стола" (Timeline). Щелкнув один раз по иконке перехода в окне 

"Монтажный стол" (Timeline), раскрываем вкладку "Управление эффектом" (Effect 

Controls) (рис.4.22). 

 
Рис. 4.22 - Окно "Управление эффектом" 

 

Для просмотра результата склейки двух видеофрагментов при помощи перехода в 

окне "Программа" (Program) нужно произвести рендеринг смонтированного фильма, нажав 

клавишу Enter. На необходимость рендеринга указывает также красная полоса рабочей 

области окна "Монтажный стол" (Timeline). 

Для каждого типа перехода будут свои дополнительные возможности настройки. Все 

они довольно просты и понятны, поэтому данный вопрос можно оставить на 

самостоятельное изучение. 

Изменить длительность перехода можно двумя способами: 

 Установить требуемое значение длительности перехода (Duration) с клавиатуры во 

вкладке "Управление эффектом" (Effect Controls). 

 Навести мышку на конец или начало перехода в окне "Монтажный стол" (Timeline); 

курсор приобретет соответствующую форму. Потянуть вправо (для увеличения) или 

влево (для уменьшения) за границу перехода для изменения его длительности. 
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Используя при монтаже переходы, необходимо избегать избыточного их применения. 

Некоторые переходы позволяют не просто оживить видеоряд, но и помогают правильно 

выстроить монтаж. 

 

Задание 7. Работа с титрами в фильме 

Титры являются неотъемлемым элементом любого фильма. Они могут состоять из 

одного слова, фразы, графических объектов; быть статическими или динамическими, 

находиться в каком-либо одном месте экрана или перемещаться по нему. Титры 

представляют зрителю название фильма, команду, работающую над фильмом (режиссер, 

оператор, актеры, художники и так далее), служат пояснением происходящему на экране 

или его дополнением. Титры, появляющиеся в самом начале фильма, называются 

начальными, в конце - заключительными. 

Программа Adobe Premiere предоставляет широкие возможности для создания титров 

непосредственно в программе. Для этого существует специальный редактор титров. Для его 

вызова необходимо обратиться к пункту меню "Файл" (File), далее выбрать команду 

"Новый" (New) и нажать на слово "Титры" (Title). В появившемся диалоговом окне 

предлагается ввести название файла титров. Далее перед вами открывается окно редактора 

титров. 

Прежде чем приступить к созданию титров, необходимо учитывать несколько правил. 

1. Соблюдать так называемую Безопасную область титров (Title Safe 

Area). Эта область соответствует второй, внутренней рамке окна редактора титров. 

Желательно не выводить титры за пределы этой рамки, так как в противном случае 

часть изображения, выходящая за безопасные границы, может быть утеряна. 

2. Помните, что цвета неодинаково отображаются на экране монитора и 

на экране телевизора. 

3. Лучше не использовать шрифты с засечками в титрах, так как тонкие 

линии (засечки) могут нечетко отображаться на экране или мерцать. 

4. При помещении титра на какое-либо изображение важно помнить, что 

надпись должна быть читаема. Для выделения текста титров часто используют тень 

и градиент (плавный переход одного цвета в другой). 

Прежде чем приступать к созданию титров, необходимо решить, на каком фоне они 

будут располагаться (черный экран, заливка каким-либо цветом или изображение). Если 

титры будут располагаться поверх изображения, то сначала нужно поместить требуемый 

видеофрагмент или графический файл на дорожку окна монтажа (Timeline) и установить 

курсор в то место линейки времени, с которого предполагается демонстрация титров. Затем 

открыть редактор титров и приступить к их созданию (рис.4.23). 
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Рис. 4.23 -Окно Редактора титров 

Основной панелью для создания титров является панель, расположенная по 

умолчанию в верхнем левом поле. Рассмотрим основные инструменты этой палитры. 

Итак, титры, создаваемые при помощи редактора, могут быть нескольких видов: 

 Горизонтальные титры 

 Вертикальные титры 

 Статические титры 

 Титры, расположенные вдоль кривой 

 Бегущие титры (Rolling Title) 

 Динамические титры 

 Перемещающиеся титры (Crawl Title) 

Чтобы создать простые статические титры (горизонтальные или вертикальные), 

нужно выбрать один из инструментов основной панели (горизонтальный текст или 

вертикальный) и затем в области просмотра при помощи мыши нарисовать рамку для 

будущих титров. Затем выбираем стиль титров из библиотеки стилей, расположенной под 

областью просмотра. Редактор титров позволяет создавать титры вдоль воображаемой 

кривой. 

 
 

 
 

 

Горизонтальные 

титры 

Горизонтальные титры вдоль кривой с 

воображаемыми линиями 

Горизонтальные титры 

вдоль кривой на экране 

Динамические титры создаются по уже знакомому нам алгоритму: сначала 

выбирается горизонтальный или вертикальный тип текста, затем текст вводится с 

клавиатуры в окно просмотра. Потом статический текст преобразуется в динамический 

следующим образом: выделяем мышью область титров и выбираем команду "Опции 

динамических титров" (Roll/Crawl Options) (рис.4.24, 4.25). 
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Рис.4.24 - Панель  

"Свойства титров" 

Настройка области титров 

 Opacity - прозрачность 

 X Position - положение по оси Х 

 Y Position - положение по оси Y 

 Width - ширина 

 Height - высота 

 Rotation - поворот 

Настройка шрифта титров 

 Font - выбор шрифта 

 Font Size - размер шрифта 

 Aspect - уплотнение или разряжение шрифта 

 Leading - изменение межстрочного интервал 

 Kerning - изменение межбуквенного интервала 

 Tracking - уплотнение или разряжение шрифта 

 Baseline Shift - положение относительно базовой линии 

 Slant - наклон букв 

 Small Caps - только строчные буквы 

 Small Caps Size - размер строчных букв относительно 

исходного 

 Underline - подчеркнутый шрифт 

 Distort - искажение шрифта по осям X и Y 

Заливка для текста 

 Fill Type - тип заливки (сплошной, градиент) 

 Color - цвет сплошной заливки 

 Opacity - прозрачность цвета заливки 

 Sheen - добавление цвета и его параметры в тексте 

 Texture - использование текстуры 

Изобразительные эффекты 

 Inner Strokes - для заливки букв 

 Outer Strokes - для контуры букв 

Тень 

 Color - цвет 

 Opacity - прозрачность 

 Angle - поворот 

 Distance - расстояние между тенью и буквой 

 Size - размер тени 

 Spread - степень размытости 



75 
 

 
Рис. 4.25 -Создание динамических титров 

 

На экране появляется диалоговое окно, позволяющее задать параметры для бегущих 

(Rolling) или перемещающихся (Crawl) по экрану титров (рис.4.26). 

 
Рис. 4.26 - Задание параметров динамических титров 

Область "Тип титров" (Title Type) определяет будущие титры как: 

 статические (Still); 

 бегущие (Roll); 

 перемещающиеся (Crawl). 

 В опции "Направление" (Direction) задается направление этого вида 

титров: справа налево (Crawl Left) или слева направо (Crawl Right). Область "Отсчет 

времени" (Timming) позволяет настроить скорость воспроизведения титров на 

экране. Для этого используются следующие параметры: 

 Начать воспроизведение за пределами экрана (Start Off Screen). 

 Закончить воспроизведение за пределами экрана (End Off Screen). 

 Задать (с клавиатуры) количество кадров, предшествующих 

воспроизведению тиров (Preroll), и количество кадров, воспроизводимых после 

окончания титров (Postroll). 

 Задать количество кадров для ускорения титров (Easy-In) и для их 

замедления (Easy-Out). Кроме текста титры могут содержать различные графические 

объекты, создаваемые при помощи инструментов основной панели 

(прямоугольники, овалы, линии, треугольники). 

Для настройки расположения одного и более объектов (текста и графических 

объектов) служит палитра "Действия" (Actions) (рис.4.27).  
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Рис. 4.27 - Палитра "Действие" 

Для выполнения действий над объектами все они должны быть выделены при помощи 

мыши. Если необходимо выделить несколько объектов, для этого нужно удерживать 

нажатой клавишу SHIFT, щелкая при этом левой кнопкой мыши на нужные объекты. 

По окончании работы над титрами достаточно просто закрыть окно редактора титров. 

При этом файл, содержащий титры, появится автоматически в окне "Проект" (Project). 

Затем его нужно будет перетащить мышкой в окно "Монтажный стол" (Timeline).  

 

 

Окно монтажа Изображение в окне "Монитор" (Monitor) 

Если требуется внести какие-либо коррективы в титры, то для этого достаточно 

дважды щелкнуть по иконке титров в окне "Проект" (Project) или "Монтажный стол" 

(Timeline). Нужный вам файл с титрами сразу автоматически откроется в редакторе титров. 

 

Задание 8. Работа с динамической прозрачностью 

Раскроем видеотреки окна "Монтажный стол" (Timeline), на которых находятся файлы 

с изображением (нижний) и файл с титрами (верхний). Посередине файлов проходит 

желтая линия, а сверху рядом с названием файла появилась надпись Opacity 

(Прозрачность). Эта линия называется "Ленточный регулятор прозрачности". Нам нужно 

настроить прозрачность для файла с титрами. Если при помощи мыши потянуть ленточный 

регулятор вниз, то надпись (титр) исчезнет, то есть станет полностью прозрачной. 

Теперь попробуем сделать эффект прозрачности динамическим. Для этого вернем 

ленточный регулятор в исходное положение. Мысленно разделим длительность клипа на 

четыре части. Установим курсор окна "Монтажный стол" (Timeline) в начало и щелкнем на 

кнопку "Добавить/Удалить ключевой кадр" (Add/Remove Keyframe) .На желтой полосе 

появится значок ключевого кадра. Передвинем курсор чуть вперед и поставим еще один 

ключевой кадр. Проделаем ту же процедуру в конце клипа (незадолго до конца клипа и в 

самом конце). В результате трек с титром должен приобрести следующий вид (рис.4.28, 

4.29): 

 

 
Рис.4.28 - Расстановка ключевых кадров в окне монтажа  
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Рис. 4.29 - Корректировка положения ключевых кадров 

 

Отсмотрим полученный результат в окне Монитор (Monitor). Нам удалось выполнить 

поставленную задачу: надпись плавно появляется в начале и плавно исчезает в конце. Если 

вы хотите удалить ключевый кадр, то на него необходимо установить курсор окна 

"Монтажный стол" (Timeline) и нажать кнопку "Добавить/Удалить ключевой кадр" 

(Add/Remove Keyframe). Просто передвинуть ключевой кадр можно мышью 

непосредственно в окне монтажа. Наведите курсор мыши на значок ключевого кадра на 

треке (курсор немного изменит свою форму), затем, нажав на левую кнопку мыши, 

потяните ключевой кадр в нужную вам сторону. При этом в выплывающем окошке будет 

отображаться информация о текущем положении ключевого кадра на линейке времени 

(передвижение кадра влево/вправо), а также изменение прозрачности в процентах 

(передвижение кадра вверх/вниз). 

Чтобы расставить ключевые кадры, нажмем кнопку Toggle Animation .Появится 

уже знакомая нам кнопка "Добавить/Удалить ключевой кадр" (Add/Remove Keyframe). 

Используя ее, мы расставляем ключевые кадры, которые отображаются в виде 

треугольников в правой части окна "Управление эффектом" (Effect Controls). Перемещаться 

по линии времени можно так же, как и в окне "Монтажный стол" (Timeline), - при помощи 

бегунка. Настройки прозрачности будут действовать от одного ключевого кадра до 

следующего. Менять положение ключевого кадра и степень прозрачности изображения 

можно при помощи мыши непосредственно в правой части окна "Управление эффектом" 

(Effect Controls), передвигая ключевые кадры. Удалить все ключевые кадры можно при 

помощи кнопки Toggle Animation  (рис.4.30). 

 
Рис. 4.30 - Настройка прозрачности при помощи вкладки 

 "Управление эффектом" 

 

Настройка прозрачности данным образом чрезвычайно удобна, так как результат 

можно просмотреть сразу же в окне "Программа" (Program), потянув за бегунок в правой 

части окна "Управление эффектом" (Effect Controls). Однако чтобы проиграть 

смонтированный фильм с добавленным эффектом, необходимо запустить процедуру 

рендеринга. 

 

Задание 9. Создание видеоэффектов 

Эффекты, позволяющие настраивать прозрачность видеоклипов, находятся в уже 

знакомой нам по теме "Переходы" вкладке "Эффекты" (Effects). Сегодня мы познакомимся 



78 
 

с содержанием папки "Видеоэффекты" (Video Effects). Рассмотрим некоторые из доступных 

видеоэффектов, используемых для настройки прозрачности видеоклипа. 

Эффекты, позволяющие настроить прозрачность какого-либо цвета или группы цветов, 

расположены в папке Keying. Для демонстрации работы эффекта воспользуемся файлами-

примерами - исходниками самой программы Adobe Premiere, но более ранних версий. 

 

 
 

Первый исходник - 1.avi Второй исходник - 2.avi Итоговое  

изображение 

Теперь попробуем поместить изображение бабочки первого исходника на 

изображение листа второго исходника. Чтобы это сделать, нужно чтобы серо-черный фон, 

окружающий оранжевую бабочку, стал прозрачным. Для этого воспользуемся эффектом 

Chroma Key. Расположим файл 1.avi на дорожке Video 2, а на дорожку Video 1 поместим 

фоновый файл 2.avi. Произведем рендеринг. В итоге получим, что верхний клип полностью 

перекрывает изображение нижнего клипа. В папке "Видеоэффекты" (Video Effects) найдем 

эффект Chroma Key (он находится в папке Keying). Мышкой перетащим иконку эффекта на 

файл 1.avi. Откроем вкладку "Управление эффектом" (Effect Controls) и там увидим 

название нашего эффекта. Нажмем на белый треугольник, расположенный слева от 

названия эффекта, и тем самым сделаем возможным просмотр опций данного эффекта 

(рис.4.31). 

 
Рис. 4.31 - Настройка параметров эффекта Chroma Key 

 

Рассмотрим настройки эффекта. 

 Color - при помощи палитры или инструмента "Пипетка" позволяет 

выбрать цвет, который мы хотим сделать прозрачным. 

 Similarity позволяет установить диапазон цветов, родственных 

выбранному, которые также будут прозрачными. Это значение можно ввести с 

клавиатуры, либо открыв данный параметр при помощи кнопки в виде белого 

треугольника, либо установить его при помощи бегунка. При этом все изменения 

будут сразу же отображаться в окне "Программа" (Program). 

 Blend - настройка прозрачности в зависимости от цвета фонового 

клипа. 
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 Threshold - настройка диапазона темных (непрозрачных) тонов. 

 Cutoff - настройка диапазона прозрачности по параметру 

насыщенности цвета. 

 Smoothing - сглаживание границы прозрачного и непрозрачного 

участков. 

 Mask Only - прозрачна только область маски. 

Регулируя параметры Color, Similarity и Blend, нам удалось добиться нужного 

эффекта. В данном случае мы использовали настройки прозрачности для всего файла 

целиком. Если прозрачность должна изменяться по времени, то, так же как и в предыдущем 

примере, можно использовать ключевые кадры. При этом отображаться ключевые кадры (в 

виде белых ромбиков) будут в правой части окна "Управление эффектом" (Effect Controls). 

Для каждого параметра эффекта можно задать свои ключевые кадры. 

Прозрачности отдельного участка кадра можно добиться при помощи так называемой 

маски (Matte). Для этого в любом графическом редакторе (как правило, в формате TIFF) 

создается объект с тем расчетом, что черные области являются прозрачными, белые - 

непрозрачными, а серые тона - частично прозрачными. Затем файл с маской загружается в 

качестве обычного исходника в Adobe Premiere. Если на уроке остается время, можно 

продемонстрировать работу с маской. 

 

Задание 10. Реализация движения клипов 

Под термином "движение" в данном случае понимается: 

 движение в рамках одного клипа; 

 движение одного клипа на фоне другого. 

Рассмотрим реализацию движения одного клипа на примере статического 

изображения. Данный прием бывает весьма эффективен для оживления так называемых 

слайд-фильмов, частично или полностью состоящих из статических изображений, 

фотографий. В этом случае получается добиться эффекта движения камеры, что делает 

даже обычный слайд-фильм намного интересней для зрителя. 

Итак, перед нами две фотографии. На обеих - изображение Вознесенской церкви на 

горе Секирная Большого Соловецкого острова. Попробуем совместить эти два 

разноплановых кадра при помощи эффекта движения. 

 

 

Разместим оба файла последовательно на дорожке Video 1. Эффект движения (Motion) 

настраивается во вкладке "Управление эффектом" (Effect Controls). Нам нужно задать 

движение для первого клипа, поэтому выделим его, щелкнув мышкой, и откроем вкладку 

"Управление эффектом" (Effect Controls). Дизайн окна нам уже знаком по предыдущему 

уроку: в левой части окна находятся параметры настройки эффекта, в правой части 

расположена шкала времени, на которой отображаются ключевые кадры (если они есть). 
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Рассмотрим основные настройки Движения (Motion) (рис.4.32). 

 
Рис. 4.32 -Настройка эффекта движения 

 

 Position определяет положение изображения в рамках кадра. 

 Scale - установка масштаба изображения в кадре. 

 Rotation - поворот изображения в кадре. 

 Anchor Point - точка, определяющая положение картинки по осям X и Y; 

относительно нее возможно смещение изображения по вышеназванным осям. 

 Anti-flicker Filter - фильтр подавления "шумов" при изменении параметров 

исходного изображения. 

Каждый из названных параметров имеет числовое значение (синие цифры рядом с 

названием). Это значение меняется автоматически (например, при внесении правки при 

помощи мыши) либо задается с клавиатуры. 

Установим курсор в начале фрагмента в правой части окна "Управление эффектом" 

(Effect Controls) и поместим в эту точку ключевой кадр (рис.4.33).  

 
Рис. 4.33 - Изменение масштаба изображения в кадре 

 

Переместим курсор в конец фрагмента и установим здесь второй ключевой кадр. Для 

этой точки растянем изображение в кадре так, чтобы церковь на дальнем плане на первой 

фотографии примерно совпадала по композиции с той же церковью на второй фотографии. 

Для этого щелкнем правой кнопкой мыши на надпись "Motion". В окне "Программа" 

(Program) с изображением текущего кадра появится рамка, потянув за края которой, 

увеличим изображение церкви и поместим его по центру кадра.  

Поскольку в данном случае изменяются два параметра (Position и Scale), то ключевые 

кадры необходимо расставить для обоих параметров в начале и конце фрагмента (рис.4.34). 
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Рис. 4.34 - Настройка параметров Position и Scale 

 

И, наконец, между двумя кадрами наложим переход Cross Dissolve, обеспечив 

плавный переход от одного изображения к другому. В конечном итоге у нас получилась 

такая смена изображения: 

 

Исходник 1 

 

Промежуточные  

изображения 
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Исходник 2 

 

 

Теперь рассмотрим второй вариант движения одного клипа поверх другого. В данном 

случае клипы располагаются один над другим. В качестве примера попробуем наложить 

изображение чайки на морской пейзаж. Расположение клипов в окне Монтажный стол 

(Timeline) будет выглядеть так (рис.4.35). 

 
Рис.4.35 - Расположение клипов в окне монтажа для настройки эффекта движения 

 

Используя эффект прозрачности Chroma Key, сделаем голубой фон вокруг чайки 

прозрачным и при помощи параметра Scale параметра "Движение" (Motion) уменьшим 

изображение. Не забудьте выделить нужный клип перед созданием того или иного эффекта. 

В окне "Программа" (Program) получается следующая картинка (рис.4.36). 

 
Рис. 4.36 - Изменение масштаба изображения в окне "Программа" 

Далее зададим траекторию полета по ключевым точкам (Position). Для более 

правдоподобного движения добавим поворот птицы (Rotation). Масштаб картинки (Scale) 

остается неизменным. Таким образом, ключевые кадры необходимо задать только для 

изменяющихся параметров  (рис.4.37). 

 
Рис.4.37 - Окно "Управление эффектом" с измененными  

параметрами  

Задание 11. Работа с видеоэффектами Adobe Premiere 
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Видеоэффекты расположены во вкладке "Эффекты" (Effects), папке "Видеоэффекты" 

(Video Effects). Как и в случае с переходами, однотипные эффекты разложены по папкам. 

Если вы уже работали с программой Adobe Photoshop, то многие из них будут вам знакомы. 

Настройка эффектов происходит во вкладке "Управление эффектом" (Effect Controls). 

Если требуется изменение параметров эффекта на протяжении фильма, то необходимо 

добавление ключевых кадров. Если ключевых кадров нет, то эффект назначается с 

заданными параметрами для всего фильма. 

Чтобы назначить эффект клипу, нужно перетащить мышкой иконку видеоэффекта на 

клип, помещенный в окне "Монтажный стол" (Timeline). После этого клип в окне монтажа 

будет выделен темным цветом, а эффект и его параметры появятся в окне "Управление 

эффектом" (Effect Controls). 

Рассмотрим типы эффектов, которые могут быть использованы учащимися для 

быстрой и простой корректировки изображения. Ознакомление со всеми эффектами подряд 

может оказаться очень утомительным для учащихся. Для более детальной информации 

можно обратиться к файлам помощи программы. 

 Adjust - группа эффектов, направленных на корректировку цвета изображения. 

 Blur & Sharpen- создание более размытого или более четкого изображения. 

 Distort- искажение изображения в кадре (поворот, отражение, искажение). 

 Image Control - корректировка и изменение цветов в кадре.  

 Keying- задать прозрачность клипа по цвету или при помощи маски (частично уже 

разбиралось на уроке № 6). Более подробного разбора эффектов данной группы на 

уроках не предусмотрено. 

 Perspective- добавление трехмерного эффекта в кадр (эффект Basic 3D). 

 Renderсодержит эффекты Lighting, имитирующий электрический разряд, Lens Flare 

- эффект блика в камере. 

 Stylise- различные эффекты стилизации изображения (акварель, гравюра, мозаика, 

добавление "шума"). 

 Transform- трансформация кадра. 

 Video- папка содержит эффект Timeem, при применении которого на экране 

появляется счетчик времени. 

Каждый эффект имеет свои собственные настройки. Для того чтобы просмотреть их, 

надо развернуть эффект, нажав на белый треугольник рядом с названием эффекта. 

К одному и тому же клипу может быть применен один или несколько эффектов 

одновременно. Чтобы удалить эффект, его нужно сначала выделить в списке эффектов окна 

"Управление эффектом" (Effect Controls), затем войти в меню вкладки и выбрать пункт 

"Удалить выбранный эффект" (Delete Selected Effect). Чтобы удалить все назначенные 

клипу эффекты, нужно выбрать команду "Удалить все эффекты" (Delete All Effects From 

Clip). Перед выполнением данной операции проверьте, какой клип в данный момент 

выделен. 

 

Задание 12. Монтаж звука 

Для хорошего фильма очень важно звуковое сопровождение. К сожалению, 

любительское кино часто не может похвастаться качественным звуком. Чтобы избежать 
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наиболее типичных ошибок при монтаже звука, советуем воспользоваться 

нижеследующими советами. 

 Как правило, оригинальный звук (который записывается на камеру 

одновременно с видео) имеет не очень хорошее качество, прежде всего из-за 

большого количества посторонних шумов. Поэтому для фильмов звук 

перезаписывается еще раз уже в студийных условиях. Если в своем фильме вы 

хотите использовать оригинальный звук, постарайтесь свести к минимуму 

количество посторонних шумов. 

 Если требуется добавить какие-то звуки, то вы можете записать их 

самостоятельно либо воспользоваться библиотекой уже готовых звуков (например, в 

Интернете на сайте www.wavsounds.com). 

 Очень редко в фильме присутствует только речь. Для большего 

правдоподобия специально добавляются разного рода шумы (шорохи, шаги, 

скрипы). Не забывайте об этом, особенно если вы создаете отдельно видеоряд, а 

потом накладываете специально записанный звук. 

 Помните, что каждой картинке на экране должен быть подобран 

музыкальный фрагмент, соответствующий ей по настроению и ритму. Видеоряд и 

музыкальное сопровождение должны быть гармоничными. 

В программе Adobe Premiere монтаж звука по своим основным принципам схож с 

монтажом видеофайлов. 

 Качество звука в проекте задается при определении предустановок 

проекта. Одним из основных параметров здесь является показатель "Частота" (Rate), 

который определяет, с какой частотой звук представляется в цифровом виде. Чем 

выше этот показатель, тем звук более качественный. 

 Звуковые файлы загружаются в проект в виде исходников и 

размещаются в окне "Проект" (Project). Они могут быть помещены в отдельную 

папку. 

 Для монтажа звука в окне "Монтажный стол" (Timeline) существуют 

специальные аудиотреки, число которых не ограничено (Audio 1, 2, …). 

 Для звуковых дорожек доступны все те же команды, что и для 

видеотреков. 

 Режим включения или выключения трека (Toggle track output). 

 Режим открытия или закрытия трека (Toggle track lock). 

 Треугольник рядом с названием трека открывает его. Если трек 

развернут, то мы увидим амплитудный график аудиоклипа. 

 

 

Амплитудный график монофонического 

звука 

Амплитудный график стереофонического 

звука 

Для монофонических и стереофонических звуков в программе существуют разные 

дорожки. Изменить количество дорожек для уже созданного трека нельзя. Для каждого 

типа есть свои обозначения: 

Возможны следующие способы отображения аудиоклипов: 

o Show Clip Keyframes- показать ключевые кадры клипа. 
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o Show Clip Volume- показать уровень громкости клипа. 

o Show Track Keyframes- показать ключевые кадры всего трека. 

o Shoe Track Volume- показать уровень громкости всего трека. 

o Hide Keyframes- скрыть все ключевые кадры на треке. 

 Посередине каждого файла при открытом треке идет тонкая желтая 

линия (уже знакомый нам ленточный регулятор). Она соответствует уровню 

громкости клипа. На этой линии можно расставлять ключевые кадры и перемещать 

ее (вверх или вниз), изменяя тем самым громкость. 

 Самым последним треком идет так называемая мастер-дорожка. На нее 

нельзя поместить исходники. Этот трек служит для соединения и редактирования 

всех ауди-онастроек фильма. 

 Для работы со звуковыми файлами в окне монтажа могут быть 

применены те же средства и инструменты монтажа (обрезка клипов, выделение, 

увеличение масштаба отображения, перемещение по треку, разрезание клипа), что и 

для видеофайлов. Инструменты монтажа с наложением, смещением, совмещением и 

масштабирование клипов в данном случае будут недоступны. 

 Звук и видеоряд могут быть связаны между собой в единое целое. То 

есть при внесении правок в звуковую или видеодорожку (например, обрезка, сдвиг, 

выбор клипа) те же изменения будут происходить и на другой. Если вам требуется 

сделать аудио- и видеоклипы независимыми, то для этого необходимо 

воспользоваться командой "Развязать аудио и видео" (Unlink Audio and Video). 

 Для звуковых файлов возможно применение переходов: Постоянное 

увеличение (Constant Gain) и Постоянное усиление (Constant Power). 

 

Задание 13. Микширование звука 

Соединение звуков, расположенных на разных дорожках, в единое звуковое 

сопровождение фильма называется микшированием звука. Необходимо, чтобы каждый звук 

был слышен зрителю, не заглушал остальные, шел без помех. Для этого в программе 

существует специальный "Ау-диомикшер! (Audio Mixer) в отдельной вкладке. Вы можете 

видеть все изменения и эффекты, назначаемые клипам, и сразу же здесь их редактировать. 

Звук с каждого трека регулируется в отдельном столбце, заголовок которого соответствует 

имени трека. 

Работа аудиомикшера на каждой дорожке включается в нескольких режимах. Для 

нашей работы достаточно будет воспользоваться тремя режимами: 

 Off (Выкл.)- игнорирование всех звуковых эффектов для данной дорожки при 

воспроизведении; 

 Read (Чтение) - воспроизведение всех эффектов для данной дорожки; 

 Write (Запись) - запись всех назначаемых дорожке эффектов и создание 

соответствующих ключевых кадров. 

Для монтажа звука нужно установить курсор в требуемое положение и начать 

воспроизведение файла, по мере которого отрегулировать параметры. Аудиомикшер 

автоматически расставит ключевые кадры на аудиодорожках. Затем, если в этом есть 

необходимость, можно произвести коррекцию расположения ключевых точек вручную в 

окне "Монтажный стол" (Timeline) (рис.4.38). 



86 
 

 
Рис. 4.38 - Вкладка "Аудиомикшер" 

Программа позволяет производить запись звука непосредственно из окна 

"Аудиомикшер". Это бывает очень удобно, когда под воспроизводимое видеоизображение 

требуется записать дикторский текст. Для этого необходимо: 

 подключить микрофон к компьютеру; 

 выделить в окне "Линия времени" (Timeline) звуковую дорожку, на которую 

предполагается производить запись; 

 установить курсор в то положение на дорожке, откуда должна пойти запись 

(лучше немного ранее); 

 в окне "Аудиомикшер" нажать кнопку "Разрешить запись на дорожку" (Enable 

track for recording); 

 нажать кнопки "Запись", а затем "Воспроизведение", расположенные в нижней 

левой части окна "Аудиомикшер"; 

 в окне "Линия времени" (Timeline) вы увидите перемещение курсора и сможете 

записать нужный текст; 

 для завершения записи нажмите кнопку "Стоп" в нижнем левом углу окна 

"Аудиомикшер". После этого на выделенной вами ранее дорожке Линия времени (Timeline) 

появится клип с записанным звуком. Этот клип автоматически сохраняется в папке проекта 

 

Задание самостоятельной работы 

Создание видеоролика с видеопереходами и эффектами продолжительностью не 

менее 5 минут 

 Для начала импортируем видео, над которым будем работать, переносим его на 

видеодорожку. Здесь вырезаем нужные участки при помощи инструмента «Лезвие» 

 Из встроенного набора с панели «Эффекты» в папке «Видеоэффекты» выбираем 

понравившиеся. Настроить их можно на панели «Контроль эффектов». Текст можно 

вставить из одноименного меню и в открывшемся окне изменить его внешний вид.  

 Добавляем переходы с панели «Эффекты». На аудиодорожке работаем со звуком. 

Готовый файл экспортируем в желаемом формате (рис.4.39). 
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Рис.4.39 -Примерный вариант видеоролика 

 

Контрольные вопросы 

1. Что можно понимать под термином "проект" для программы Adobe 

Premiere? 

2. Для чего служит окно "Монтажный стол" (Timeline)? Почему его 

можно назвать самым главным? 

3. Для каких функций в программе служат окна Программа (Program), 

Источник (Source) и Линия времени (Timeline)? 

4. Для чего служат переходы? Подумайте, какие переходы могут решать 

те или иные режиссерские задачи. 

5. Какие типы титров позволяет создавать редактор титров программы 

Adobe Premiere? 

6. Что такое ключевые кадры? Для чего их можно использовать? 
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Лабораторная работа №5. Основы HTML и CSS 

Цель работы: Изучение элементов HTML  и основных элементов оформления. 

Задачи работы:  

 изучение структуры HTML; 

 изучить основные элементы языка; 

 получение практических навыков разработки HTML . 

 

Теоретические положения 

Структура и правила оформления HTML-документа 

Веб-обозрева́тель, браузер  — программное обеспечение для просмотра веб-сайтов, то 

есть для запроса веб-страниц (преимущественно из Сети), их обработки, вывода и перехода 

от одной страницы к другой. 

Сайт  — совокупность электронных документов (файлов) частного лица или 

организации в компьютерной сети, объединённая под одним адресом (доменным именем 

или IP-адресом). 

Все сайты в совокупности составляют Всемирную паутину, где коммуникация  

объединяет сегменты информации мирового сообщества в единое целое — базу данных и 

коммуникации планетарного масштаба. 

Веб-сервер — это сервер, принимающий HTTP-запросы от клиентов, обычно веб-

браузеров, и выдающий им HTTP-ответы, обычно вместе с HTML-страницей, 

изображением, файлом, медиа-потоком или другими данными. Веб-серверы — основа 

Всемирной паутины. 

Веб-сервером называют как программное обеспечение, выполняющее функции веб-

сервера, так и непосредственно компьютер, на котором это программное обеспечение 

работает. 

Единый указатель ресурсов (англ. URL — Uniform Resource Locator) — 

единообразный локатор (определитель местонахождения) ресурса. Ранее назывался 

Universal Resource Locator — универсальный локатор ресурса. URL — это 

стандартизированный способ записи адреса ресурса в сети Интернет. 

Веб-страница — документ или информационный ресурс Всемирной паутины, доступ 

к которому осуществляется с помощью веб-браузера. 

Веб-страницы обычно создаются на языках разметки HTML или XHTML и могут 

содержать гиперссылки для быстрого перехода на другие страницы. 

Информация на веб-странице может быть представлена в различных формах (рис.5.1): 

 текст; 

 статические и анимированные графические изображения; 

 аудио; 

 видео; 

 апплеты. 
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Рис.5.1 – Схема работы 

 

На рис.5 2 представлена история развития HTML: 

 
Рис. 5 2 – История развития HTML 

 

Простая HTML - страница 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" 

"http://www.w3.org/TR/html4/loose.dtd"> 

<html>  

 <head>  

  <title>Пример HTML страницы</title>  

 </head>  

 <body>  

  <h1>Мой первый HTML-документ</h1>  

  <hr>  

  <p>Скоро мы узнаем, что означают эти странные знаки.</p>  

 </body>  
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</html>  

Структура HTML документа 

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.0 Transitional // EN"  

"http://www.w3.org/TR/html4/loose.dtd">  

<html> 

 <head> 

  Здесь размещается служебная информация. 

 Пользователь ее не видит.  

 </head> 

 <body>  

  Здесь размещается содержание документа. 

 Именно это видит пользователь. 

 </body> 

</html>  

Типы элементов HTML 

1. Блочные (block elements)  

B. Структурное форматирование  

        2. Текстовые (inline elements)  

C. Непосредственное форматирование  

D. Логическое форматирование (phrase elements)  

1. Нежелательные (deprecated)  

2. Устаревшие (obsolete) 

3. Новые (new) 

Заголовки 

<h1>Заголовок 1</h1> 

<h2>Заголовок 2</h2> 

<h3>Заголовок 3</h3> 

<h4>Заголовок 4</h4> 

<h5>Заголовок 5</h5> 

<h6>Заголовок 6</h6> 

Формирование абзаца 

<P> Браузеры, которые интерпретируют мягкие переносы, должны обеспечивать 

следующую семантику: если строка прекращается в месте мягкого переноса, в конце 

первой строки должен отображаться символ переноса. </P> 

Атрибуты элементов (тэгов) (рис.5.3) 

 
Рис.5.3 – Атрибуты тэгов 

Использование атрибутов-тэгов 

<h1 align="center"> Выровнять по центру 

<p align="right"> Выровнять по правому краю  
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<p align="justify"> Выровнять по ширине  

<h2 align="left"> Выровнять по левому краю  

<hr size="3"> Толщина разделительной линии 

<hr noshade> Разделительная линия без тени 

<hr align="right" width="450"> Ширина в пикселях  

<hr size="3" width="50%" align="center">  

Форматирование цитат (рис.5.4) 

<blockquote> 

They went in single file, running like hounds on a strong scent, and an eager light was in 

their eyes. Nearly due west the broad swath of the marching Orcs tramped its ugly slot; the sweet 

grass of Rohan had been bruised and blackened as they passed. </blockquote>  

 
Рис. 5.4 – Форматирование цитат 

Авторское форматирование 

<pre> 

Время –         

 начинаю   

  про Ленина рассказ. 

Но не потому, 

       что горя 

         нету более, 

время      

     потому,             

      что резкая тоска 

стала ясною            

     осознанною болью. 

</pre> 

Элемент ADDRESS - контактная информация 

(Блочный элемент, текст отображается курсивом) (рис.5.5) 

<p>Мой адрес:<address> ГГНТУ, пл.Орджонокидзе,100</address> 
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Рис.5.5 – Элемент address 

 

Группировка элементов 

Элементы DIV и SPAN вместе с атрибутами id и class обеспечивают общий механизм 

добавления в документы структуры. Эти элементы определяют встраиваемую информацию 

(SPAN) или информацию уровня блока (DIV), но не налагают никаких других выражений 

для представления контекста. 

<div align="center"> 

  Блок номер 1  

  <div> 

    Блок номер 2 

    <div> 

    Блок номер 3 

    </div> 

  </div> 

</div>  

Элементы DIV и SPAN (рис.5.6) 

<div id="main"> 

 <div class="one">Первый div</div> 

 <div class="one">Второй div</div>  

 <div class="one">Третий div</div> 

 <span class="two">Первый span</span>  

 <span class="two">Второй span</span>  

 <span class="two">Третий span</span> 

</div> 

 
Рис.5.6 - Элементы DIV и SPAN 

Коротко о цвете 

Шестнадцатеричная система счисления: 

0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F 

 

Диапазон: 00 - FF (0 - 255)  

#00FF00 – green (зеленый)  

#FF0000 – red (красный)  

#0000FF – blue (синий)  

#FFFFFF – white (белый)  

#000000 – black (черный)  
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#FFFF00 – yellow (жёлтый) 

#FFD700 - gold (золотой) 

#FFCC00 - tangerine (мандариновый)  

#E49B0F - gamboge (гуммигут) 

#FDE910 – lemon (лимонный)  

Безопасная палитра цветов:  

00,33,66,99, CC,FF (216 сочетаний). 

 

Изменение цвета страницы и шрифта (рис.5.7) 

<html>  

 <head>  

  <title>Раскрашиваем страницу</title>  

 </head>  

 <body bgcolor="silver" text="#0000FF"> 

  <p>Этот текст синего цвета,  

  <font color="red"> а этот - красного.</font>  

  <hr color="green">Горизонтальная линия тоже может быть разноцветная.   

 </body>  

</html>  

 
Рис.5.7 - Изменение цвета страницы и шрифта 

 

Непосредственное форматирование текста 

<i> - курсив </i>  

<b> - полужирный </b>  

<u> - подчеркнутый </u>  

<strike> - перечеркнутый </strike>  

<tt> - моноширинный </tt> 

<big> - увеличить шрифт </big> 

<small> - уменьшить шрифт </small> 

<sup> - надиндекс </sup> 

<sub> - подиндекс </sub> 

Логическое форматирование 

<em> - выделение важных фрагментов курсивом  

<strong> - выделение особо важных фрагментов полужирным  

<ins> - выделение фрагмента подчеркиванием, когда требуется показать явно, что 

текст был вставлен после опубликования документа.  

<del> - выделение фрагмента перечеркиванием, когда требуется показать явно, что 

текст был удален после опубликования документа.  

<cite> - выделение цитат курсивом  

<code> - отображение фрагментов программного кода моноширинным шрифтом  

<kbd> - текст, вводимый с клавиатуры: отображается моноширинным шрифтом  
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<var> - название переменных: отображается курсивом  

<samp> - выделение нескольких символов моноширинным шрифтом  

<dfn> - определение вложенного термина курсивом  

<abbr title="Какое-то слово"> - аббревиатура 

<acronym title="Какое-то слово"> - акроним  

<q lang="ru"> - определение кавычек  

Специальные символы (таблица 5.1) 

Таблица 5.1 

&nbsp;  &#160;  Неразбиваемый 

пробел  

 

&quot;  &#034;  Прямая кавычка  "  

&amp;  &#038;  Амперсанд  &  

&lt;  &#060;  Знак "меньше"  <  

&gt;  &#062;  Знак "больше"  >  

&copy;  &#169;  Копирайт  ©  

&reg;  &#174;  Зарегистрировано  ®  

&trade;  &#153;  Торговая марка  ™  

 

 Задания для самостоятельной работы 

1. Оформите HTML-файл следуя инструкциям, указанным ниже в виде комментариев. 

a. <!-- создайте заголовок первого уровня красного цвета 

выровненный по центру -> 

b. <!-- отрисуйте горизонтальную линию --> 

c. <!--пройдите вниз по документу и сделайте все заголовки: 

a) типа 1. - заголовками второго уровня 

b) типа 1.1 - заголовками третьего уровня 

c) типа 1.1.1 - заголовками четвертого уровня --> 

2. Существует шесть уровней заголовков - от H1 (наиболее важный) до H6    

(наименее важный). Все заголовки имеют полужирное начертание и вертикальные отступы. 

Примеры заголовков: 

<!-- создайте заголовки соответствующих уровней и выделите их как блочную цитату 

--> 

 Заголовок 1 уровня 

 Заголовок 2 уровня 

 Заголовок 3 уровня 

 Заголовок 4 уровня 

 Заголовок 5 уровня 

 Заголовок 6 уровня 

3.  Элементы P и DIV 
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<!-- 

- оформите каждый фрагмент текста отдельным абзацем с помощью  элемента p,  

- все абзацы поместите внутрь элемента div 

- задайте выравнивание align=right для div   

--> 

Элемент P создает параграф. В нем не могут содержаться элементы уровня блока 

(включая и сам элемент P). Также нежелательно использовать пустой элемент P, так как 

браузеры игнорируют пустые элементы P. 

Элемент P добавляет вертикальный отступ перед и после абзаца. Применяется 

параграф для облегчения чтения текста и логической группировки связанных по смыслу 

предложений. 

Элемент DIV может содержать как внутренние элементы, так и блочные и 

применяется для структурного разделения документа. Крайне часто применяется при 

верстке страниц с применением CSS, что дало ей определение «блочная». 

Наряду с элементом в будущем DIV будет часто использоваться элемент SPAN для 

форматирования частей строк. 

4.  Форматирование текста с помощью элемента PRE 

Элемент PRE сообщает визуальным агентам пользователей, что пробельные символы 

внутри не нужно сокращать и переносить по ним длинные строки. Очень не рекомендуется 

применять в элементе символ табуляции. В элементе могут находиться только строчные 

элементы. 

5.  Подстановки 

Подстановки используются в тех случаях, когда использование 

обычных символов невозможно, либо нужно заменить признак тэга на 

графические символы угловых скобок. 

В тексте обязательной замене подлежат открывающая угловая скобка и амперсанд. 

Желательно заменять закрывающую угловую скобку, одиночные и двойные кавычки. 

<!-- 

Основные подстановки: 

&lt; (открывающая угловая скобка) 

&gt; (закрывающая угловая скобка) 

&quot; (двойная кавычка) 

&apos; (одиночная кавычка) 

&amp; (амперсанд) 

--> 

 Пример: фрагмент кода 

<!-- оформите фрагмент так, чтобы он выдавался на экран именно в таком виде, как 

стоит в коде: --> 

Голландская фирма Horns&Hoofs запустила online-магазин 

6.  Элемент FONT 

Элемент FONT изменяет размер, цвет и гарнитуру шрифта для текста. Начиная с 

версии HTML 4.0 перенесен в категорию «нежелательные элементы» (deprecated elements) и 

подлежит замене на элемент SPAN (будет полезно при использовании CSS). 

7. Атрибут SIZE: размер текста 
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<!-- оформите слова после двоеточия в каждой строке элементом font с 

соответствующим размером --> 

SIZE = «1»: пример текста 

SIZE = «2»: пример текста 

SIZE = «3»: обычный текст 

SIZE = «4»: пример текста 

SIZE = «5»: пример текста 

SIZE = «6»: заголовок H1 

SIZE = «7»: пример текста 

8. Атрибут  COLOR: цвет текста 

<!-- оформите слова «пример текста» в каждой строке соответствующим цветом --> 

red = «#ff0000»: пример текста 

green = «#008000»: пример текста 

blue = «#0000ff»: пример текста 

black = «#000000»: пример текста 

gray = «#808080»: пример текста 

silver = «#c0c0c0»: пример текста 

9. Атрибут  FACE: выбор гарнитуры шрифта 

<!-- оформите слова «пример текста» в каждой строке соответствующей гарнитурой --

> 

face = «arial, verdana, sans-serif»: пример текста 

face = «georgia, times, serif»: пример текста 

face = «courier, monospace»: пример текста 

face = «cursive»: пример текста 

face = «fantasy»: пример текста 

10. <!-- используйте разные способы выделения текста --> 

Изменение размера и положения текста 

Формула расчета энергии: 

E=mc2 

Химическая формула воды 

H2O 

Изменение начертания и гарнитуры 

I: Курсив 

B: Полужирное начертание 

U: Подчеркивание 

TT: Моноширинный шрифт 

Смысловые элементы («phrase elements») 

EM: Смысловой акцент 

STRONG: Ударение на части текста 

CITE: Цитата или ссылка на другие ресурсы 

CODE: Фрагмент компьютерного кода 

11.  <!-- добавьте горизонтальную линию hr --> 

 

Контрольные вопросы 
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1. Основные сведения о языках разметки: HTML, XML, XHTML.  

2. Что такое WEB-сервер, web-сайт, web-страница и чем они отличаются. 

3. Что такое тег? Типы элементов. Понятие тегов и атрибутов. 
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